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Chapter 1

Introduction

Kofax ReadSoft Invoices

Kofax ReadSoft Invoices is a business solution that interprets invoices you receive from your suppliers.
The interpreted information is checked and validated according to your requirements. Then the
information is transferred to a file. Invoices can be customized to read and interpret invoices in a variety of
formats, including:

Paper

Fax

PDF

Email

XML (ReadSoft Collector or Invoice Portal)

Sorting

Invoices can automatically sort invoices by buyer, supplier, country, and invoice type. Sorting reduces the
scan operator’s manual work and automates invoice routing.

» Buyer (legal entity) identification — Invoices can automatically search for and identify buyers on each

invoice.

Supplier identification — Invoices can use bank account numbers and other information on an invoice to
identify the correct supplier.

Country sorting — Invoices can automatically recognize an invoice’s country of origin by identifying the
supplier. Invoices can also be routed and verified according to the country of origin.

Invoice classification — Invoices can differentiate and sort invoices by type. Types of invoices include
general expense invoices (GE), purchase order invoices (PO) and credit notes.

Who uses Invoices?

Normally, three different groups of people at your company work directly with Invoices.
* A software administrator installs Invoices.
* An administrator sets up the program to work efficiently with your invoices. This person also manages

the Invoices database.

* Department personnel use Invoices to process invoices.
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Using this book

The Invoices Handbook is intended primarily for new users who want to learn the basics of Invoices.
» Chapter 1 explains what Invoices is and summarizes some of the key features.
» Chapter 2 gives you an overview of Invoices.

» Chapter 3 guides you through the basic steps that help you to get started in preparing for production.
This chapter only requires your PC and the Invoices Manager module.

» Chapter 4 continues the tutorial with a presentation of the steps required to process invoices in each of
the production modules. You use the four production modules and a scanner in this chapter.

» Chapter 5 describes how to use the Optimize module to learn new invoices and increase production.

After Invoices is installed, you can use the guidelines in Chapters 3 through 5 to process your own
invoices. These chapters show you how to perform basic operations in the correct order.

You can find information on specific concepts, menu choices, or functions of interest in Invoices Help. It
is easily accessible while running the program in each module by pressing F1 or choosing Help topics
from the Help menu in each module.

Use the glossary in the back of this book to familiarize yourself with new terms.

Typographical conventions

These conventions are used throughout product documentation:

* Menu names, commands, and dialog selections appear in boldface.

» Page numbers in the index which refer to a page with a definition appear in smaller boldface.
* Names of keys on your keyboard appear in a special font with small capital letters.

* Field names and variable names appear in this font.

» Variables that have to be replaced by the actual value appear in the same font as above but are
italicized (for example, Fieldname).

« Names of files are written in this font.

Handbook tutorials

We suggest that you follow the steps described in Chapters 3 through 5 using the sample material
provided with Invoices. Sample invoices and master data are included with the installation. You can find
the sample invoices in the Images folder (default location: C:\Program Files\ReadSoft\Invoices\Samples
\). The sample master data is located at the same location in the Master data subfolder. You can print
the sample invoices and use a scanner to scan them into the system. Or, if you do not have access to a
scanner, you can import the images directly into the system.

By completing the tutorial, you will understand the basics of Invoices. For example, you will see how
buyer and supplier identification work as well as other key concepts such as country sorting and invoice
classification.
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The six modules

Invoices is comprised of six separate modules, each with a user friendly interface:
* Manager

* Scan

* Interpret

* Verify

» Transfer

* Optimize

The modules can be run separately or simultaneously, on one computer or in a network. In this way, work
can be planned to enhance computer capacity and personnel efficiency.

Collector can also be used as a Data source extension to be able to process invoices that are emails/
attached to emails as images or XML files in the same way as paper invoices are processed.

Entrance mode can also be used to process documents other than invoices such as customer orders
using generic non-invoice based terminology. This can be configured separately for individual users.

Manager

You use the Manager module for system and database administration and for defining Invoices’ settings.
Among other things, you use Manager to manage:

* Users

* Invoice profiles

» Transaction descriptions

» Scanner descriptions

» Job descriptions

* Inboxes for the Verify module

* Maintenance plans

» Buyer and supplier information (master data)

Scan

The Scan module controls the scanner and sends invoice images to Invoices. Details it can handle
include:

» Advanced, integrated functions for image enhancement.

* Endorsing each paper invoice with a number as it is scanned.
» Appendices or attachments to invoices.

» Batches, or stacks of invoices that you process together.
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Interpret

The Interpret module reads incoming invoices and captures the information you need. Using master
data from your financial system, it can recognize the buyer and suppliers for each invoice and sort them
accordingly. The Interpret module can also automatically classify invoices by type.

Verify

The Verify module quickly and securely validates interpreted invoice information according to internal
routines and settings that you specify using the Manager module.

During production, the Verify operator checks invoices for accuracy and makes any necessary
adjustments before sending the invoices to Transfer.

Verify has an inbox that lets you decide which invoices you want to verify. Administrators can customize
the inbox using hierarchical folder views that organize the invoices in a way that is meaningful to their own
production system. For example, you can use the inbox to sort invoices by buyer, supplier, country, and
type.

Transfer

The Transfer module sends information from processed invoices to a target system via a transfer file.
The target system can be an archive, workflow, or financial system. The target system can be another
application on the same computer as Invoices or on another computer on the network.

Optimize

You use the Optimize module to speed production by increasing interpretation and identification
performance of problem invoices. The Optimize module is not used in everyday production.

Optimize is most often used when setting up Invoices for the first time. During this time, all incoming
invoices are new to the system, and the invoices that cannot be automatically learned by Interpret and
Verify must be learned in Optimize. Automatically learned invoices can also be optimized to improve
production performance.

Interface languages and Entrance mode
The interface language is specified individually for each user.
The Invoices 6.1.0 interface is translated into twenty three languages plus Entrance mode.

Entrance mode terminology is generic so that it can be used to process documents other than invoices,
such as customer orders, if desired.

Collector plugin

Collector is used to process invoices that are sent by email (or it can be used to retrieve invoices directly
from a file folder). XML documents can be processed in connection with Collector using Invoices’
SmartXML functionality.



Chapter 2

Invoices overview

This chapter contains an overview of what you do to set up Invoices at your company and how
department personnel use the program to process invoices.

The overview introduces important concepts and some of the terms that are used in Invoices. However,
please note that many important and powerful Invoices functions are not mentioned in this overview.

There are three basic phases of work you do with Invoices:
* Preparing for production involves setting up Invoices before invoices are processed. You do this using

the Manager module. Chapter 3 contains a tutorial that takes you through the steps in preparing for
production.

Production involves scanning, interpreting, and verifying invoices, as well as transferring information
from processed invoices to an output file or target system. You do this using the production modules:
Scan, Interpret, Verify, and Transfer. Chapter 4 teaches you how to process invoices using the
production modules.

Optimization involves fine-tuning invoices for increased interpretation rates and improved production.
Chapter 5 explains how to do this using the Optimize module.

Preparing for production

After installing the program, you must set up Invoices for production. Setting up Invoices includes activities
such as defining user access rights and importing master data. It also means telling the program about
your suppliers, their invoices, and how to process them.

"Setting up Invoices”To prepare for production, you must define these core settings:

Users — to determine who can access Invoices and what tasks they can perform.
Scanner descriptions - to specify settings that are valid for your scanner.

Invoice profiles — to tell Invoices what information to capture.

Job descriptions — to give Invoices the processing instructions for each module.

Transaction descriptions or XML Output format — to determine the format of the output of the captured
information.

Note that these are only the basic settings required to use Invoices. Additional settings and options
will be discussed throughout the remainder of the handbook, and even more options are described in
Invoices Help.

10
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User authorization

User authorization requires Invoices users to supply a user name and password when starting any
module. There are two types of user authorization:

» Local user— uses Invoices own, built-in system to control user access.
» Network authentication - uses Microsoft Windows users and groups to control access to Invoices.

Local authorization is enabled by default. You can change this setting when you create users for
Invoices. For more information about user authorization, see Invoices Help.

Master data

Master data is information about your buyers and suppliers. It includes details such as company names,
addresses, and phone numbers. It can also contain supplier identification numbers for your financial
system and supplier account information.

Invoices can import master data and use it to automatically identify the buyers and suppliers of your
invoices.

Invoice profiles

An invoice profile is a general description of the information that you want to capture from a particular
group of invoices. A single invoice profile can handle invoices from hundreds, or even thousands, of
different suppliers.

Among other things, an invoice profile defines:
* How to locate and process the invoices
» How to identify the invoices
» The fields you want Invoices to capture
» The format of the transaction information from processed invoices
An invoice profile contains:
» One to three identifiers used to identify invoices.
» Field profiles describing the fields you want to capture.
» A transaction description, which defines what information you want to transfer.
» A scanner description, which defines the scanner settings and invoice paper size.

Invoices includes predefined invoice profiles for many different countries. These “country profiles” are
fully loaded with the most popular field profiles as well as country-specific business logic and validation
routines. In many cases, country profiles can be used with very little or no adjustment at all.

Identifier profiles

An identifier is a field that is used to recognize each invoice. An identifier profile describes an identifier and
tells Invoices how to find an identifier on an invoice. You can define as many as three identifier profiles

for each invoice profile. If you use more than one identifier, you can use the invoice profile Identification
settings to control how the identifiers are used.

1
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There are two types of identifiers, value and image. A value identifier contains alphanumeric characters,
while an image identifier contains graphical elements such as a company logo.

An identifier is unique to each type of invoice. Therefore, the usual identifier defined is an account number
or a telephone number that is different for every supplier. It is this unique value that the program uses to
recognize the supplier’s invoice.

Field profiles

Field profiles tell invoices what information you want to capture. Typical fields are:

* Invoice date A field contains information you want to capture.
* Invoice number

&
*  Amount e A field contains
+ Tax a—— — information you
+ Total == want to capture.

iN
== T = 4537
e ‘55\*-"“;“---,0- & GATE

A 03-11-99 /

"Field profile” You need one field profile for each field you want to capture on the invoice. Each field
profile includes information that tells Invoices how to locate the field, what the field looks like, and how to
interpret the field.

When an invoice is processed by the Interpret module, the program looks for fields on the invoice. When
Invoices finds a field that matches the properties specified in the field profile, it captures the information in
that field.

Job descriptions

A job description is a set of instructions describing what you want a specific Invoices module to do. It tells
each production module (Scan, Interpret, Verify and Transfer) which invoices you want to process and
how you want Invoices to work.

You can create and edit a job description using the Manager or any of the other modules. However, in the
other modules, you can only change the details that pertain to that particular module.

We often refer to job descriptions in connection with a production module name, for example Scan job
description. This simply refers to details specified for that module in the Job description dialog. In fact,
there are details for every production module saved in each job description.

* A Scan job description tells Scan how to process the invoices to be scanned.
* An Interpret job description tells Interpret which invoices to interpret and validate.

12
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A Verify job description tells Verify which invoices you want to verify and what status they should have
in order to do it. You can also choose from many options for how you want the program to interact with
you during the verification process.

» A Transfer job description tells Transfer what information you want to capture and where you want to
send it.
You can create as many job descriptions as you like for different purposes, and you can edit them right
up until the time you use them. You can create different job descriptions for the same invoice profile in
order to divide your work in different ways or in order to allow each user to customize the settings. A job
description with default settings is perfectly usable as-is.

Jobs

During everyday use of Invoices, personnel run jobs (job descriptions) to process invoices. A job performs
a specific type of processing such as scanning invoices. Some types of jobs are interactive, while others
do not require manual intervention.

It is useful to create a few job descriptions in advance in order to have a well-defined environment for the
personnel who use Invoices. When defining job descriptions, you specify a number of options in each job
that control what you want Invoices to do.

The four types of jobs are:

Job Function Interaction

Scan Starts the scanner, scans invoices, and Operating the scanner.
creates an image file for each invoice.

Interpret Identifies and matches the scanned No personnel interaction. Can run with
invoices to known suppliers. a graphical interface or as a Windows

Captures and validates the information on | service.
identified invoices.

Learns new, unidentified invoices.

Verify * Displays any fields that require an Verifying and completing field values.
operator to manually verify or type the
field value. Presents interpreted invoices
for adjustment and approval.

Transfer Exports the captured invoice information | No personnel interaction. Can run with
to afile. a graphical interface or as a Windows
service.

* If you choose to use the inbox in Verify, you can optionally hide the Verify job in the Verify module.

Understanding invoice definitions

An invoice definition is a collection of settings that describe one type of invoice from one supplier. Invoice
definitions are normally created in Verify when new invoices enter the system. The program uses the
identifiers, and optionally master data, on the invoice definition to recognize the supplier’s invoice and find
information on it.

When the program cannot match an invoice to an invoice definition, the invoice is Unidentified. You can
match unidentified invoices with suppliers when:

13
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Verifying invoices using Verify.

Learning invoice definitions using Optimize.

What is learning?

Learning is the process of creating an invoice definition that fully describes the fields on the invoices from
a particular supplier. To learn an invoice, the program has to find and interpret all of the invoice’s fields.
After an invoice is learned, Invoices can identify additional invoices of the same type and automatically
capture the information on them.

Based on the information in the invoice profile, Invoices can successfully learn many fields without user
assistance.

If Interpret cannot fully learn the invoice, you can learn the invoice manually using Optimize. Manual
learning means that you use Optimize to assist Invoices in identifying any fields that Interpret could not
learn.

There are two important concepts that you need to understand about Invoices and learning:

 Field definition”"When Invoices learns an invoice from a specific supplier, it saves the information
about this specific invoice type in an invoice definition. Position, format, and other information about a
particular field on the invoice definition is stored in a field definition. The next time an invoice from the
same supplier is processed, Invoices finds and captures all information using the invoice definition and
field definitions as a guide. The difference between an invoice profile and an invoice definition is that an
invoice profile is used for learning unidentified invoices from any supplier, whereas an invoice definition
is used to define an invoice from one particular supplier.

* Invoices processes all invoices from the same supplier in exactly the same way. Invoices assumes
that the fields on an invoice can always be found using the "rules” specified in the invoice definition.
The only exception is a variant. A variant occurs when you have two invoices, from the same supplier,
that have different field positions. In this case, the variants are distinguished by a description that
accompanies the supplier. See Invoices Help for more information about suppliers and descriptions.
After processing an invoice and learning it, Invoices has the ability to identify invoices from the same
supplier and capture the information on them with little or no manual intervention required.

For additional information about learning, refer to Invoices Help.

Information transfer

When an invoice is processed, the Transfer module creates a fransaction containing the captured
information, system information, and any information you may have entered manually. "Transaction
description” When you set up Invoices, you create a transaction description, which specifies the content
and format of the transactions. Each transaction is saved in a transfer file that is used by your financial
system.

A default transaction description is part of every complete invoice profile. You can also specify additional
transaction descriptions in the Transfer job description.

You can also use the Transfer job description to choose which invoices are transferred according to
their status and specify whether or not each invoice should be deleted from Invoices’ database after it is
successfully transferred.

14



Kofax ReadSoft Invoices User's Guide

The standard transaction description

There are three types of transaction descriptions, only one of which is required: the standard transaction
description. You use the Manager to create one standard transaction description for each invoice profile.
The standard transaction description is a necessary part of a complete invoice profile.

Understanding transactions and transaction descriptions is essential in order to use Invoices effectively.
Before you begin creating transaction descriptions, read about them in Invoices Help. In particular, read
about creating a standard transaction description. When you create a standard transaction description,
you decide what information your organization wants to get from the processed invoice and the preferred
format of the information.

Production

While the Manager and Optimize modules are used for administrative work, the remaining four modules
(Scan, Interpret, Verify, and Transfer) are used during production.

During everyday use of Invoices, department personnel run jobs in the various modules as described
below in the four phases of production.

You can do all four phases of production on one computer, or you can use a different computer for each
phase, if the computers share the same database.

Scanning invoices (Scan)

The Scan module controls the scanning phase. Images of the invoices are produced by the Scan job for
the Interpret module to process. Details it can handle include:

» Advanced, integrated functions for image enhancement.

» Endorsing each paper invoice with a number as it is scanned.
* Appendices or attachments to invoices.

» Batches, or stacks of invoices that you process together.

Interpreting scanned invoices (Interpret)

The Interpret module identifies and interprets invoice information. It identifies different suppliers by
interpreting unique identifiers on each invoice and matching them to suppliers in the database. Invoices
from new suppliers are learned as completely as possible, and the information on these invoices is
captured.

Interpret can run continuously and process invoices as they become available from the Scan module. You
can also automate Interpret as a Windows service.

Interpret can also use master data to identify which buyer, or legal entity, is responsible for the invoice,
and Interpret can identify which country the invoice comes from as well as classify the invoices type. This
is called sorting.

15



Sorting

Sorting occurs in the Interpret module. Invoices can automatically sort invoices by buyer, supplier, country,
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and invoice type, and uses that information to determine which invoice profile to use. Sorting reduces the
scan operator’s manual work and automates invoice routing. When the supplier, buyer, and invoice type
are identified, Invoices knows which invoice profile to use to process the invoice.

Validating and verifying invoices (Verify)

The Verify module uses internal and online routines, as well as tables in your financial system, to validate
information interpreted by the Interpret module. You use the Verify module to verify that information on the

invoices is correct.

B Verify - INVOICES 5
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Verifying an invoice in Verify.
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Depending on the options in the Verify job description, Invoices displays images of the information to be
adjusted and approved. It is the job of the Verify operator to complete and correct any fields that Invoices
cannot interpret with 100% certainty, as well as fields you want checked for any reason.

The user-friendly interface has advanced functions for image handling, which enhance zooming and
panorama methods. Operators can accomplish the work efficiently using a wide range of functions such
as the inbox which organizes incoming invoices in a way that is meaningful to the Verify operator.

=-[23 *our Company GER
[y GER-FO
=-[Z3 ouwr Company GER
[ GER-GE
[ GER-PO
+-[0 Unknown buyer
@ Unknown countny

The inbox is highly customizable.

After invoice processing has been completed in Verify, the information is ready for transfer.

Transferring information (Transfer)

The Transfer module transfers information from processed invoices to a target system via a transfer file.
The target system can be another application on the same computer as Invoices or on another computer.

The information is transferred in transactions. A transaction is information resulting from processed
invoices, which Invoices transfers to another system. When you run a Transfer job, the start date, start
time, and elapsed run time are also displayed, and you see a bar chart which shows how many invoices of
each type are transferred.

Transfer can run continuously and process information as it becomes available. You can also automate
Transfer as a Windows service.

Optimization

You can use the Optimize module to help Invoices find a field or specify information about a field. Optimize
displays the invoice image on the screen, and you use your mouse to mark the field on the invoice image.
This is part of Invoices’ manually assisted learning function.

Before optimizing an invoice, consider whether or not it is worthwhile to do so. For example, if you have

a supplier whose invoices could benefit from optimization, but you seldom receive invoices from that
supplier, it is probably not cost-effective to optimize the invoice. On the other hand, if you frequently
receive invoices from that supplier, optimization can increase production speed, saving you more time and
resources.
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Customization

Invoices is designed to be a part of a complex environment, and its open interface makes it easy to
integrate with a variety of other systems.

You can customize the program to suit your requirements, modifying its functionality and adding more
features. You do this with your own Visual Basic for Applications (VBA) code or DLL (Dynamic Link
Library) functions (written in any language capable of producing DLLs), or by writing ActiveX event servers
residing in a DLL or .EXE file. For example, you can add dialogs, ActiveX automation calls, ODBC access,
file manipulation, and much more.

Invoices offers you this access via the Events page, which you can access from the Manager and from job
descriptions. An event is the result of an activity at a specific point in a program. As invoices move through
the production modules (Scan, Interpret, Verify and Transfer), events are fired at predefined occasions.

When an event is fired, Invoices checks to see whether you have defined a handler for the event. An
event handler causes execution of a predefined VBA function, DLL function or both.

VBA and DLL programming is a complex task which requires knowledge of Visual Basic, C, C++,
or ActiveX automation. Invoices API Help contains a language reference for Invoices’ application
programming interface (API).

VBA and DLL functions can be quite powerful. They can change values on invoices and even cause
Invoices to malfunction. We recommend you proceed with caution when implementing event handlers.

Getting around in the program

The graphical user interface (GUI) provides a visual means of using Invoices and makes standard
program operations easier to use.

Most of the functions that can be performed by the menus and the toolbar buttons can also be done by
clicking objects on the GUI. For example, if you are running the Manager module, and you want to create
a new invoice profile, you can do so by choosing New (File menu), or you can right-click the empty space
under the Invoice profiles object bar, and select New.

The GUI also serves as means to display object properties. If you look at an invoice profile’s icon in
the Manager module, for example, you can see if the invoice profile is open, closed, or locked in the
database. For more information on icons, see Invoices Help.
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» Manager - INVOICES 5

File Edit Wew Administration Settings Plug-ins Help

NSH||BRf2|@esn|x
I

| Invaice praofiles
EJ GER-GE
=-E3 Identifier profiles
. ~[# waTRen
EJ Logo
~[2] TelephoneMumber

=453 Field prafiles

Debit/Credit
IrvviceMurnber
InvoiceD ate
Metyalue
WATRate
WATY alue
GrossWalue
Currency

Y

----- [Z3 Dpened invoice definitions
#-[E GBR-FO

+-E GER-FO

| 4y Job descriptions
St

Transaction descriptions
Tahles
Batch report layouts
Scanner descriptions

Users
Ready I
The Manager Window
1 Invoice profile
2 Identifier profiles
3 Field profiles
4 Object bars

Note that the menu options are context sensitive. In other words, the menu functions are related to the
current active object. In the example above, right-clicking the white space under the Invoice profiles object
bar gives you the option to create a new invoice profile. However, if you click the Job description object
bar, right-clicking and selecting New will create a new job description. Likewise, if you right-click an invoice
profile folder, only options related to the selected folder will be available.
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Job description
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=- Scan Invoice profile:
Pages
Endorzer r
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Events [ Save statistics
= Interpret [ wWait mode
Source
Select
:‘:) Queues
: Sart
Ewents
=1 Yerify
Status
Select
3 Huetiss Enter general settings which apply to all parts of the job
Sort description.
Contral —
Werify order
Ewvents
=|- Tranzher
Status
Select b ok Cancl
The Job description dialog.
1 General settings
2 Settings
3 Verify job description
B Verify - INVOICES 5
Fle View lob Invoce Help
@a . geaale
Buyer Supplier rumber
i YourConpany GBF =]
e d2E8 v
5-:_"3?: Name jalue 0
e @imoreNumber T Buyer: Supplier number:
fenursssg (©ImvoiceDate 20041107
e 11 Your Company GBF > |
O VATRate 17.50% ) L.
S i Supplier: Description:
- - ML Industries |
Name va
| e || nem || v || e | | o | | e | a iceMurmber 1087
1 @1 123 on ST 0 19.99 O 1.9
2|2 © 1235 o1 st ©019.39 019,99
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R e TR a1 ST 31099 1099 L |
© LrstenTate astron | Dosen] b
administrator Invoice: 171

The Verify module puts buyer and supplier information at your fingertips.
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The Verify module is designed to give you a quick overview of invoice information and makes the )
verification process quick and easy. You have access to important buyer and supplier information, and $
the unique traffic-light system quickly tells you which areas need attention.

Accessing Invoices Help

Invoices Help contains the most up-to-date information available on the product. If you have a basic
understanding of Invoices, having read this book and worked through the tutorial, it is easy to find the
information you want in Invoices Help.

F1

The easiest way to access Help is to press F1 on your keyboard. You can do this at any time while you
are using Invoices. F1 is context sensitive, which means that the topic most closely related to whatever
you are doing appears.

Note: In some cases F1 displays an overview topic, and you must look for the desired information using
the Contents, Index, or Search tab.

The Help menu

Each Invoices module has a Help menu. Select Help topics to access Invoices Help.

T Manager - INVOICES 5 L EX

Eil= Edit Yiew Administration Setbings Plug-ins | Help

ReadSoft Home Page

About INYOICES. ..

Select Help topics to open Invoices Help.

Accessing Help from outside Invoices
You can access InvoicesHelp even if no Invoices window is open. Using Windows Explorer, locate the

main help file, INVOICES5_ENG.chm. It is located in the Bin folder. Double-click this file and use Invoices
Help as you normally would.
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Chapter 3

Preparing for production

The instructions in this chapter take you through all of the basic steps in setting up Invoices for use in
production.

In this tutorial, you will set up Invoices for an imaginary company consisting of two legal entities, Your
Company GBR and Your Company GER. The legal entities represent your imaginary subsidiaries in
England and Germany.

You will use the sample master data to provide Invoices with information about your imaginary companies
and suppliers. Then you will create a working production system that can process the sample invoices.

All of the steps in this chapter will be performed using the Manager module.

Steps to prepare for production

Before you can use Invoices in production, complete the steps listed below. Detailed instructions on each
step follow.

1.
2.
3.

© o N »

Define user authorization settings (required)

Import master data from your financial system and adjust the master data policy (recommended)
Create an invoice profile for each legal entity (required)

» Adjust, add, or delete identifier profiles

+ Adjust, add, or delete field profiles

Add a standard transaction description and mark it as default (required for each invoice profile)
+ Determine the physical layout of the output

» Set the default transaction description

Create a scanner description (required if using a scanner)

Create a job description (required)

Check and activate the invoice profile (required)

Define inbox settings (recommended)

Test the invoice profile (recommended)

Define user authorization settings

By default, Invoices asks you to supply a user name and password when starting any module. This is
called local user access. Local user access is Invoices own, built-in system to control user access.
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Optionally, Invoices can use Microsoft Windows users and groups to control access to Invoices. This is
called network authentication. See Invoices Help for more information about user authorization.

For the tutorial, we will turn off user access:

1. Start the Manager module from the program group created during installation or run the program

eimngr.exe.

4

<, KPS Viewer
| Accessories

Windows Update

. Games

. Maintenance

. Microsoft SQL Server 2008
| Microsoft SQL Server 2012
. ReadSoft

.. INVOICES 5-8

@ 1. Manager

m 2.5can

7 3. Interpret

B 4. Verify

JE 5. Transfer

T Optimize

| Documentation
. Links

.. INVOICES Database Configuration

Back

Search programs and files

 Windows Media Center
@ Windows Media Player

Documents
Pictures

Music

Computer

Control Panel
Devices and Printers

Default Programs

Help and Support

Invoices default program group.
If this is the first time Manager has been started, the Login dialog appears. Type the user name and

password and click OK.

Login

User:

Admin

Password:

Change password

The default User is “Admin” and the default Password is “secret”.

If this is the first time Manager has been started, the Getting started dialog appears. For the
purposes of this tutorial, you can simply click Close to close this dialog.
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4. Select User authorization from the Settings menu in Manager.

&) User authorization @
Enable user authorization for
Manager
Cancel

Scan

Interpret
Verify

Transfer
Optimize

The User authorization dialog determines which modules are password restricted.

5. Deselect each module to disable user authorization. Now you can access any module without having
to log in.

Import master data

Since master data is created/edited in the ERP system where it originates from, it is important to import
the latest information on a regular basis to help ensure that Invoices can continue to automatically match
invoices with suppliers.

Master data is imported via a maintenance plan. You can use maintenance plans to perform routine
operations such as database maintenance and master data import. A maintenance plan lets you save
master data import settings and can be reused again and again. This comes in handy, if your master data
changes often.

To create a maintenance plan to import master data:
1. Select Maintenance (Administration menu). The Maintenance dialog appears.
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2. Click New to create a new plan.

[ Maintenance

Maintenance plans

=

‘ New

Maintenance plan

Plan type
Lag file
Location

_) Database

@) Master data import

Select Master data import in the Maintenance plan dialog.

3. Select Master data import in the dialog that appears and click Next to continue.

4. Use the Log file settings to specify where to save the log file and what to do if the file already exists.
You must type a file name in the Log file name box or specify an existing file using the browse button.
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5. Click Next to specify where the log file is to be kept and how it is to be handled.

Maintenance plan ﬂ

Plan type
Log file Log file name:
Location | =

* Append

" New name

" Overwrite

" Autoname

Help
<Back Next> Cancel ‘

Note that you have to click the folders button (__ | ) to select a location before you can specify
=

the name of the log file.
6. Click Next to define the Location settings.

These settings determine where to find the files that contain the master data you want to import.
Invoices can import master data in these formats:

+ XML

+ Tab-separated file

* Microsoft Excel

» See Invoices Help for more information on how to format your master data for importing.

For this tutorial, you will import the sample XML files (default location: C:\Program Files\ReadSoft

\INVOICES\Samples\Master data). The files include information about your imaginary companies
(buyers) and your suppliers. Later, you can view the supplier information in the supplier registry,
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which you access from Manager and Verify. You can also view the buyer information in the buyer
registry, which you can only access from Manager.

Maintenance plan ﬁ

Plan type

Log file Import format:

Location ‘XML j
Suppliers
‘C.\supphers xml
SupplierBanks
‘C'\suppher-banks xml
Buyers
‘C.\buyers.xml

W Delete master data not included in import

Help
<Back FEinish Cancel

Use the browse buttons to specify the location of each master data file.

7. Click the first browse button (...) and use the Open dialog to specify the master data file containing
supplier data (suppliers.xml). Do the same for the supplier banks (supplier-banks.xml) and buyers

(buyers.xml).
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8. When you are satisfied with the settings, click Finish and name the maintenance plan in the dialog
that appears.

[ Maintenance

Maintenance plans

W

Open

Start

Delete

didil

New maintenance plan ﬁ

Name

\master-d ata

oK Cancel | Help |

Help

Close

i

Name the maintenance plan and click OK to save it.
Now that you have created a maintenance plan, you can run it to import the master data.
To run a maintenance plan:

9. Select the maintenance plan you want to run in the Maintenance dialog.

10. Click Start. After you click Start, Invoices asks if you want to run the maintenance plan. Click Yes if
you are certain you want to run the maintenance plan.

See Invoices Help for more information about maintenance plans.

Master data policy

After you have imported the master data, you tell Invoices that you want to use the master data to assist
identification. To do this:

1. Select Master data policy (Settings menu).
2. Check both settings in the dialog that appears:

Use imported supplier data for identification, and display it in Verify when searching for a
supplier

Allow Verify operators to choose suppliers from the supplier registry only (not add now ones)
Click OK.

Creating an invoice profile

Before you start processing invoices, you must tell Invoices what kind of information the invoices contain.
You do this by using the Manager to create an invoice profile. The invoice profile tells Invoices what to
look for on your invoices.

28



Kofax ReadSoft Invoices User's Guide

What to capture

The most important step in preparing for production is deciding what fields you want to capture. The
fields you capture determine not only which field profiles you need, they also affect invoice identification,
validation, and output.

To make this task easier, Invoices provides ready-made invoice profiles, which include the most commonly
used fields and business logic. All you have to do is adjust the invoice profile to suit your needs. You can
adjust the existing fields, delete ones that you do not need, and create new fields if necessary.

Create a new invoice profile

For the purposes of this tutorial, we will create three invoice profiles: two for your imaginary company in
England (Your Company GBR) and one for your imaginary company in Germany (Your Company GER).
Your Company GBR will have one invoice profile for purchase order (PO) invoices and one for general
expense (GE) invoices. Your Company GER will only have one invoice profile for purchase order invoices.

To create a new invoice profile:
1. Click the New button (") in Manager.

2. When the Create new object dialog appears, select Invoice profile and click OK.

%, Create new object ﬁ
] Invoice profile
2 Job description
% Transaction description
“» Scanner description
71 Table
& User
OK Cancel
A

The New dialog
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3. When the New invoice profile dialog appears, type a name for the invoice profile in the Name box.
For this tutorial, you will create a general expense invoice profile first, so you can name it “GBR-GE”.

# New invoice profile &

Name:
|GBR-GE

Country:
|Great Britain (GBR) |

Type:
|GE standard ﬂ

Description:

This is a standard invoice profile for general expense invoices.

Create | Cancel |

The Country box determines what predefined fields your invoice profile will contain.
4. Use the Country box to specify which country your invoices come from.
The Country box determines what predefined fields the invoice profile will contain. It also tells

Invoices how to apply business logic when capturing information. The number and names of the field
profiles that appear can vary, depending on the country you select in the New invoice profile dialog.

For the purposes of this example, we will use Great Britain.
5. Select the type of invoices you want to process with the invoice profile in the Type box and click

Create. The new invoice profile appears under the Invoice profiles object bar, complete with
predefined identifiers and field profiles.

Before we adjust the invoice profile, create two additional invoice profiles. In all, you should have
three invoice profiles with these settings:

Name Country
GBR-GE Great Britain (GBR)
GBR-PO Great Britain (GBR)
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GER-PO Germany (GER)

Three invoices profiles in the Manager module.

Opening and closing an invoice profile

Before you can edit an invoice profile, you must make sure it is open. Invoice profiles can be closed to
prevent accidental changes while in use.
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» Manager - INVOICES 5 mx

File Edit View Administration Settings Plug-ins Help

P &3 SNE NN
Invoice profiles ‘
10 (G
0.0 GBR,  MNew
+-0 GER- Add 4
Open I}
Close
Save
Save as...
Copy...
Upgrade...
Delete
[ Invoice N L
- Invoice definitions...
5 Job des Invoices...
& Transac Batches...
[ Tables Queues...
i Batch re Settings...
> Scanner Print

& Users

B Ready

» To open invoice profile so you can edit it, right-click the one you want to open and select Open.
» To close an invoice profile to prevent editing, right-click the one you want to close and select Close.

Working with field profiles

After you have created an invoice profile, you are ready to adjust the field profiles. You need to review the
settings of each field profile to ensure they meet your requirements. You may find that some field profiles
need to be adjusted slightly, while others are unnecessary and need to be deleted. You may also need to
create additional field profiles.

When using the sample invoices, you do not need to adjust any field profiles. However, when you process
invoices of your own, some adjustments might be necessary to improve performance.

Study the identifier and field profiles. Decide what fields you need to delete, add, or adjust (if any).

Adjusting identifier profiles

There must be at least one but no more than three identifiers in your invoice profile. This field identifies the
supplier by a unique value or image. By using more than one identifier, you can identify an invoice by both
images and values that can be adjusted in the invoice profile identification settings.

Value identifiers differentiate suppliers by a unique value such as an account number, supplier number,
etc.

Image identifiers recognize suppliers by a unique image, such as a logo.

You may find that some of your suppliers can be identified by a unique value, while others can only be
identified by their logos. In this case, you must use both a value and an image identifier to process all of
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your invoices. Invoices can utilize up to three, different identifiers in one invoice profile to manage your
processing needs.

Value identifiers

Assume that you decide to use the VAT registration number (available in invoice profiles for Great Britain)
as one of your identifiers. If all of your suppliers print their VAT registration numbers on their invoices, this
is the field to use because it is different for each supplier.

1. Double-click the invoice profile to expand the profile tree.
2. Expand the Identifier profiles folder.
3. Double-click the VATReg identifier profile to view its settings.

B
File Edit View Administration Settings Plug-ins Help
0 cF SNENi=N;
Invoice profiles
=B GBR-GE
=47 Identifier profiles
--[H VATReg

@ Logo Value identifier profile @
@] TelephoneN

] Generall
12 Field profiles )

| Titles Name: VATReg
IJ Transaction desq ' | Placement
1 Job descriptions| | () Validation
-] Opened invoice | | Interpretation Format
-0 GBR-PO
W) -
GER-PO Numeric
""""" Alpha,
[> Invoice profiles Pl uppercase

L0 Alpha. |
%35 Job descriptions ["] Alpha. lowercase

[] Special characters
% Transaction description

Space
[ Tables .
i Batch report layouts

A Scanner descriptions Specification:

& Users {A(0-2)N@)AITA[EINAD-TN(5-B)A}

B Ready

OK l I Cancel

4. Double-click a field profile to view its settings.

Check the format

The format tells Invoices the number and type of characters you expect to find in the specified field. For a

complete list of format specifications with examples, see the format specification table in the Quick notes
section of this book.

If you use the VATReg identifier profile with the sample invoices, you are only capturing numbers, so the
character type is N. Since the number of characters in the VAT registration number is always the same,
you specify “9” as the length of the field.

1. Verify that the Numeric box is selected.
2. Make sure the correct format is typed in the Specification box.
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Specifying titles

Titles help Invoices locate fields. A title is text that is printed on the invoice to identify the information in a
field. For example, the date of an invoice is often printed next to the title “Date”.

%-:- A title helps
= w | INVOICES find
— afield

411537
INVOICE DATE ||

pia188 |

b

In general, if the field you are defining has a title, specify all the different title texts that can occur. It does
not matter whether you use uppercase or lowercase letters, or a combination of the two. When Invoices
learns a new invoice, it uses these title texts to find the field. Invoices also uses titles when processing

already learned invoices to find fields that have a variable position on the invoice.

To specify additional titles for a field profile:
1. Click Titles in the dialog.
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2. Type a new title in the Title box.

You do not have to enter variations of titles that include spaces, such as vat reg number, because
Invoices automatically handles spaces in titles. However, if there are other abbreviations or
synonyms for the title, you can insert as many variations as needed.

Value identifier profile @
G I .
enera v | Use titles to search for value
. Titles
) Placement
) Validation
] Interpretation Title: Selected titles:
vatreg Add vatno
vatnumber
Titles in file: | Delete | vatregistration
vatregistrationno
vatregistrationnumber
vatregnno
VATREGNO
| Title file... |
(]
| Addall |
| OK | | Cancel |

Invoices uses the text in the Selected titles box to identify the field you want to capture.
3. Type the text in the Title box, and click Add to copy it to the Selected titles box.
4. Click OK to save your changes and exit the dialog.

Adjusting field profiles

Study the field profiles to determine which ones you can keep the way they are, which ones need to be
adjusted, and which ones need to be deleted.

There are three field profile types: single item, table, and barcode.
» Single item field profiles are used to capture one unit of information.
» Table field profiles are used to capture a collection of single item fields that are related to each other

physically or logically. There are several types of table field profiles: line item, VAT, and bank account.

» Barcode field profiles can be used to capture information contained in barcodes.

Some of the settings are the same as you used when working with the value identifier. Here are some
things to keep in mind when working with field profiles:

» Check the Placement settings. Judge whether the field usually has a Fixed or Variable position on a
typical invoice. Also, check the position of the field value in relation to the title.

* When defining a date field, set the Language. Invoices uses this when interpreting dates.
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» Look at the invoices when adjusting the list of field Titles. It is important to include all possible titles.
Invoices cannot automatically find a title that is not included in the list.

Creating a single item field profile

If you need to create additional field profiles when processing your own invoices, do this:
1. Right-click the Field profiles folder and select Add single item field.
2. Enter a suitable name for the field you want to capture in the Name box.
3. Select afield type from the Field type box.

The field type determines what sort of validation routines and business logic will be performed on the
field during interpretation. See Invoices Help for more information on the Field type setting.

If you do not want to connect the field to predefined business logic, you can leave this setting blank.

4. Specify the field Format for regular fields and date fields using the same method described above
(see “ Check the format”). The field Type describes the content of the field:

Regular fields can contain any allowed characters.

Date fields contain a day, a month, and a year. You do not have to specify the format of a date field
unless you want to.

Amount fields contain a monetary amount. They have automatic formatting and cannot be changed.

Single item field profile =

. Im Name:
] Titles =
] Placement Field type: | - ‘
(-] Options
[ : Validation Format
il Table validation
(] Events Type |Regu|ar v|
| Interpretation 7] Numeric

Alpha. uppercase

Alpha, lowercase

Special characters

Space

Specification:
Cancel

5. Add titles in the same manner described above (See “Specifying titles” above.).

Note: If a value identifier already exists that you want to use as a field profile, it can be automatically
copied to the Field profiles folder by right-clicking the identifier and selecting Copy to single item
field.

Specify the field position on the invoice

Invoices also needs to know if the field is always in the same place, or if it can have a variable position on
different invoices from the same supplier.
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Invoices is better at finding fixed fields than variable fields, so whenever possible, specify a field position
as fixed. You can always change the field position specification later in the Optimize module if it turns out
to be variable.

Note that “fixed position” does not mean fixed to within a millimeter, but fixed to within a small area that
allows for minor variations in printing.

The default selections will suffice in most circumstances.
1. Select the Placement setting in the Single item field profile dialog.
2. Select each Value location box where you expect to find the field value.
The Value location tells Invoices where to find the value in relation to the title. Each value position
check box represents an area where Invoices will look for the value. If you are certain, for example,
that the field value will only be found to the right of the title on all the invoices, select only the check

box directly to the right of the title. If the value position varies from invoice to invoice however, you
can select more than one position.

3. Inthe Value position on invoice box, select the appropriate radio button to specify the field position
as fixed, horizontally fixed, vertically fixed, or unspecified.

Single item field profile X|
(-] General Value location
[ Titles
#]Piacement o
] Options [~ Title v
(] Validation r & v
(] Table validation
(| Events
] Interpretation Value position on invoice
o= e

r 1 @ e

Rotation

Abc

Paragraph
[ Enable

oK Cancel

The Placement settings tell Invoices where to find the field you want to capture.
4. If necessary, adjust the field rotation by clicking the button in the Rotation box.

Specify how the value should be validated

You can optionally specify validation criteria for the field. Validation criteria are used when invoices are
processed. Invoices checks whether the field meets your criteria. Fields that do not meet the specified
validation criteria are displayed during the verification process, so that department personnel can identify
any possible problems.
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You may also want to apply a checksum validation to the value. If you want to do this, read more in
Invoices Help.

Specify other settings

There are a number of optional settings that you can specify for additional processing of the field. You
access these by selecting Options and Events. For more information, see Invoices Help.

Saving a field profile

When you have completed the field profile, click OK. The New field profile dialog closes, and the field
profile is saved to the invoice profile you are working on.

It is helpful to know the field profile belongs to the invoice profile that you opened or are in the process of
creating. If you ever want to look at (or update) this field profile again, you have to open the invoice profile
that you saved it to first.

You can edit a field profile or change its name by opening the invoice profile and double-clicking the field
profile. Before doing so, make sure the invoice profile is not being used in production. Also note that you
cannot change the name of a field profile after you have created a transaction description.

Deleting a field profile

To delete a field profile, or identifier profile, select the field profile in the profile tree and press delete.

Preparing to transfer captured data

The Transfer module is used to transfer data from processed invoices to a target system or file. The
information can be transferred using XML output (see “Configure a job to use XML output” below) or
transactions (see “Add a transaction description” on page 41).

Configure a job to use XML output

Invoices can transfer captured data in XML format. You can use Invoices' internal XML format or any
other desired external XML format. XML output is a part of Transfer and can be used for XML invoices,
scanned invoices, and imported images.

To export the results of processed invoices in XML format:

1. In Manager, click the Job descriptions object bar and double-click an existing job description to
open it, or right-click in the area above the object bars and select New to create a job description.
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2. Click Transfer and select XML Output in the transfer job description’s General
settings.

Job description X

- Buyer - Invoice profile:

- Select
GBR-PO e
- Queues J

- Sort I Use batch mode

- Events

- Verify

- Status I Wait mode (Transfer)

- Select

e QB LIES

e St
Control
Verify order
Events

B Standard transaction description:

Status — §
. Selact |<-E=fau\t- J

I Save statistics (Transfer)

W XML output

e QUELES
e Sort

- Qutput These settings apply to the Transfer job description and
. Qutput format override other General settings.

. Image

- References
- Advanced
- Events

OK Cancel |

3. In the Output page of the dialog, using the Output directorybox, specify the folder where the files
are to be
saved.

Job description ﬁ

- Buyer - Qutput directory
-Select
-Queues |C:\INV_production\Output
-Sort

- Events

®

I Create subdirectory for each day

-

... Status

-Select Single output file

- Queues -

Sort

- Contral

-Verify order

.. Events

- Transfer
... Status

- Select

Queues
- Sort W Multiple output files

m Max. invoices in each file: 1

- Output format

File name:

-

Multiple output files

-Image File name creation: Extension
- References

Advanced ﬂ | ﬂ

.. Events

oK Cancel |

Optional: Use the Multiple output files settings to determine how the XML files are saved. It is
selected by default when XML Output is selected in the Transfer General settings dialog (see step
2) and ensures that a fixed number of invoices is saved in each XML file (specified using the Max.
invoices in each file setting).
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4. Optional: Adjust the Output format settings:
Job description @

....... Buyer ASCIl format

------- Select Terminate with Code page
....... Queues 1952

»

....... Events

- Verify
- Status

Record size

w

o

=
=

....... Verify order

....... Events
- Transfer XML format

....... Status XML output transformation
------- Select ASL transformation file name

"""" Queues Famples\XML\ReadSoftinvoice56 T oHimlxs]

....... Output

------- Qutput format
....... Image

------- References
------- Advanced
....... Events

m

Cancel

By default, output is saved using Kofax’es own XML format. Using XML output transformation, it is
possible to transform the output to a different XML format by specifying a different XSL file to format
the text.

Add a transaction description

Now that you have defined the invoice profile, it is time to create a transaction description.

"Transaction description” A transaction description is used to format the output from processed invoices.
It specifies the content, format, and physical layout of the information the Transfer module will send to a
transfer file after invoices have been processed.

You must do one of the following:

» Define at least one, default transaction description for each invoice profile.

» Define one transaction description for each type of invoice.

For this tutorial, we will define one transaction description for each invoice profile. If you have many

invoice profiles, however, we recommend defining one transaction description for each type of invoice.
See Invoices Help for more information.

Create a transaction description

1. Make sure the invoice profile for which you want to create a transaction description is open.
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2. Right-click the Transaction descriptions folder under the invoice profile and select Add.

3. Click Default "Default button in transaction descriptions” to obtain a transaction description for the

4,

Determine the physical layout of the output

The transaction description options determine the layout of the output. Assume you want the transaction

Invoice profiles
E| -8 GBR-GE
¢ -] Identifier profiles
1 Field profiles
(8] Transaction G
&y BTN

uj Opened invoice definitions

invoice profile. You see that Invoices creates a number of transaction fields that include both system

variables, which begin with the "# ” character, and all the fields defined in the invoice profile.

Transaction description - @
Connected to invoice
Tt No. Field name Idx Format Pad always Len Pos Expression o . Default
¥ 1 #Profile 0 "1 o 1 1
cRoe - Delete ol
2 #Date 0 YYMMDD 1] ] 12
Available fields: 3 #Status 0 0N(R) a 2 18
-
#BatchDate = 4 #Time 0 hhmmss 0 6 20
#Batchldx ‘: | 5 Lineltems 0 x(800) i 8.. 26
#BatchNo b
#BatchPrefix 6  #BatchPrefix 0 -""X(11) © 11 B..
#BatchTime 7 #Batchho 0 +"0"N(E) O I
#Buyer
#BuyerCorporat 8  #Batchldx 0 +ON@4) 0 4 8.
#Buyerhumber 9 #BatchDate 0 YYMMDD O 6 8. oK
#Credit —
#Currency 10 #BatchTime 0 hhmmss 0 [ [ﬁ
#Date h 11 nehitiCredit 6 -""(1-70)_0 oA Eancel

The Transaction description dialog with default transaction fields.

You can use the Available fields box and the right-arrow button to add fields to the transaction

description.

To remove an unwanted field from a transaction description, select the field and click the Delete

button.

See Invoices Help for more information about using the Transaction description dialog.

to consist of the transaction fields separated by commas, with trailing zeros or spaces removed from each

field.

1.
2.
3.

Click Options (Transaction description dialog).

Select Comma between fields.
Select Compact.

You can also choose to have no separation between transaction fields (keep in mind that this can
make the information hard to read) or to separate fields with a tab. Special characters can be used
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as separators by selecting Other separator and adding the character to the text box. If you select
Compact, trailing zeros and spaces are removed from each field.

Transaction description options @

Field separation

( ! No separation Dguutatmn marks
( | Tab between fields Compact
(@ Comma between fields

(" other separator:

Batch report layout file

o[ ]

The line separation selections you made in the Transaction description dialog.
4. Click OK to save your changes and exit the dialog.

Save the transaction description

1. Close the Transaction description dialog by clicking OK.

2. Name the transaction description and click OK. Now the transaction description is associated with
the currently open invoice profile.

MNew name @

Enter new transaction description name

Name: GBR-GE

oK l l Mo J l Cancel

Name the transaction description in the Save transaction description as dialog.
3. In the Invoice profile, click Save.
The transaction description is saved with the invoice profile.

You can edit a transaction description at any time by opening the invoice profile (if it is not already
open) and double-clicking the transaction description.

Resave the invoice profile each time you edit a transaction description.

Set the default transaction description

Sometimes more than one transaction description can exist for an invoice profile. Before you can use an
invoice profile in production, you must tell Invoices which transaction description is the default standard
transaction description.

To set the default transaction description using the Manager module:

Right-click a transaction description and select Default.
Note that a red check mark appears on the transaction description icon.
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Invoice profiles

= GBR-GE

u_j Identifier profiles

-] Field profiles

Elqj Transaction descriptions

Lo
----- 2] Job desc S
b u_j Opened Save as
= GBR-PO Delete
@~ GER-PO Print
Default l\é

n.1

Create a scanner description

Scanner descriptions allow you to make settings that are valid for your scanner. They can be linked to
an invoice profile, so you can use one scanner description for all your invoice profiles, or create multiple
descriptions for different scanners.

To create a scanner description:
1. Click the New button in the Manager module.
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2. When the New dialog appears, select Scanner description and click OK.

Scanner settings Fujitsu 3096E: --- @
Paper Color
A3 - S [ T (@) Black and white
m Min. sizes o
Ad+ 0*0mm Grayscale (8 bit)
AS =| 0F0mm Color (24 bit)
BS
Legal Max. sizes
Letter 0*0mm ] )
* 0 *0mm
+
*
* MName: Ad
: width: | 210
+
* - | Height: 297 . -
Two-sided: 4 !

Document feed: Min. Max.

Automatic feed - ‘

Select scanner... Advanced
Rotate Rotate back:

l Use default settings ‘

o ) [ oo ]

The Scanner settings dialog
3. Click Select scanner and select your scanner model from the dialog, then click OK.

4. Select a paper size. Invoices has a number of predefined paper sizes. The sample invoices have A4
format, which is selected by default.

If none of the predefined sizes fits the invoice you want to define, you can either select a larger paper
size than the actual invoice or define a new paper size.

5. Select the DPI. In most cases, we recommend that you consistently use the default setting, 300 DPI,
to scan small text more effectively.

6. Change the scanner settings Light, Contrast and Rotate only if necessary, after consulting Invoices
Help.

7. Click OK to close the dialog.

8. When the next dialog appears, enter an appropriate name for the scanner description and click OK.
The scanner description is saved and can be seen under the Scanner descriptions object bar.

Create a job description

A job description is a set of instructions that describes what you want Invoices to do. It tells which invoice
profile to use and how you want Invoices to work.
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You can create job descriptions for all four of the production modules using the Manager, and you use
them to run jobs in the other modules.

When you create job descriptions, you have many alternatives and choices to make. The following steps
show the basic options needed to run the program.

Job descriptions and sorting

You can connect a job description to a specific invoice profile, however, in order to take advantage of
Invoices’ automatic sorting, we highly recommend connecting the job description to the system profile. In
essence, using the system profile is like using all of the invoice profiles at once, so Invoices can sort the
invoices properly.

To demonstrate the power of sorting, we will use the system profile in the tutorial.

Note that the system profile does not appear under the Invoice profiles bar in Manager. It is built into the
system and cannot be changed. For more information on job description settings, see Invoices Help.

Step 1 - Create a new job description

1. Click New on the Manager Toolbar.
2. When the New dialog appears, select Job description and click OK.
3. Select <SYSTEM> from the Invoice profile box.

Job description @
M - Invaice profile:
=-Scan [«svsTEM> -
........ Pages
-------- Endorser [ Use batch mode
E‘a’:r:‘:g [] Save statistics
= Interpret [] Wait mode
Source
Buyer
Select E
Queues
Sort
Events
= Verify
........ Status
........ Select
........ Queues
........ Sort
........ Control These settings apply to all modules in this job description.
-------- Verify order
Events

= Transfer
Status

Select
)

The Job description dialog

Step 2 - Edit the Scan job description settings
1. Click Scan (Job description dialog).
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2. Select the scanner description you want to use from the Scanner description box.

Job description @I

- General - Invoice profile:

R S can) [<sysTEM> v
.. Pages

.. Endorser [] Use batch mode

... Batching

... Events

nterpret

- Source

Buyer

- Salact

... Queues

- Sort

... Events

S Verify Scannerl A

... Status

- Select

.. QUEUES

- Sort L

- Control These settings apply to the Scan job description and
- Verify order override other General settings.

m

Scanner description:

. Events
[=)- Transfer
Status

.. Selact
[aTTrAT

s [ o ]

Select the scanner setting you want to use with the job description.
For information on additional Scan job description settings, see Invoices Help.

Step 3 - Edit the Interpret job description settings

1. Click Source under the Interpret job description settings.
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2. Adjust the source settings.
+ If you plan on using a scanner to scan invoices into the system, select Internal in the Invoice

source box.
Job description @
General - Invoice source
(@) Internal

() Import invoice image files

-------- Batching
-------- Events
[=J-Interpret

........

() Data source extension

m

- Verify

This setting determines where INVOICES Interpret
should get the image files to process.

[ Transfer
........ Status Choose Internal when image files are created by
________ Salect INVOICES Scan.

[aTIrm

[k [ gwes ]

Internal is the default selection in the Invoice source group box.

+ If you plan on importing image files, instead of scanning, select Import image files in the Invoice
source box and click the Configure button. Select “*.*” in the Files of type box and specify the
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folder where your image files are located in the Source directory box. This is explained in more
detail later in the section, “Skip the Scan module during testing.”

Job description @
o General - Invoice source
- Sean ) Internal
.- Pages - | Configure image file source and destinations @
- Endorser @) Import im General
- Batching ) Data sour . .
" vrte Files ofype:
[ Interpret . hd [ Advanced >> ]
- i Scanner description:
e Buyer
o Sott mage scanning DPI:
- Evienits 300 -
= Veri
o enf:.' Status [] Always show configuration dialog
o Select Source directory:
- Gueuss CAINV_production
- Sort This s4
e Cairttrol Interpre Move files
- Vierify order
... Events Choosq |dentified:
Ao ki INVOIQ Y 4
- o o CMINY_production’ldent
Error:
CMNY_production®Emor
Log file
[ Save log file
Log file name:
=
If log exists:
[ ok || cancel |

Although the default Interpret job description settings are all that is needed to run an Interpret job,
there are many ways to customize your Interpret job. See Invoices Help for more information.

Step 4 - Edit the Verify job description settings

Although the necessary Verify job description settings are predefined, there are many ways to customize
your Verify job. See Invoices Help for more information.
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Step 5 - Edit the Transfer job description settings

Next, edit the Transfer job description. It tells Invoices what information to transfer, which invoices to get it

from, and where to send it.
1.
2. When using the system job, select “<Default>" from the Standard transaction description box.

Click Transfer (Job description dialog).

lob description

m

(o]

Imvoice profile:

[<SYSTEM> -
[] Use batch mode

[] Save statistics (Transfer)

[7] wait mode (Transfer)

[] XML output

Standard transaction description:
| <Defautt> -

These settings apply to the Transfer job description
and overnide other General setlings.

(oK ] [(Cones

General settings for the Transfer job description
Select Output under the Transfer settings.

Specify the Output directory, and in the File name box under Single output file, type the name of
the file that you want the data to be transferred to, such as transfer.txt.
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Note When choosing to transfer the information to an existing file, activate the Append to existing
file box if you do not want to overwrite previously saved data. If you fail to do so, a warning dialog will
appear when you run the job in the Transfer module.

Job description @
e St . Output directony
- Events
CAINV_productionOutput
- Status [] Create subdirectory for each day
-~ Select [] Temporarily rename working file
Queues
Sort ) :
o Cortral Slnglel output file
e VexiFy order Single output file
- Events File name:
= Transfer
o Status transfer b
Select [T Append to existing file
Queues -
Sort 1 Muttiple output files
[] Multiple cutput files
Output form: L. )
.- Image Mae. invoices in each file: 1
- References File name creation: Extension:
Advanced
- Events i
] 1 ¥

[ oK ][ Cancel ]

In the Transfer job description dialog, you specify how you want the invoice information to be
transferred.
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5. “Status” Use the Status settings to choose the status of the invoices you want to transfer. The
Status settings also determine:

Whether or not the invoices are to be deleted after transfer
Where to save the image files, if you wish to save them after transfer
For information about other job description options, see Invoices Help.

Job description

Sort
i Events
S Verify
o Statu

- Select
- Queuss
o Sort
- Control

- Verify order
e EvEnts
(=]~ Transfer

- Select
- (ueues
- Sort
s OLEPUE
< Quitput forme
- [mage
- References
- Adwanced
- Events

~

=

Invoice statuses to process:

fipp
[ Adjusted
[7] Rejected
[] Complete
] Scanned

Approved
[] Delete transferred invoices

[7] Keep status

[] Move invoice images here:

[l

[

oK

=N

With these settings selected, only Approved invoices will be transferred.

6. Click OK to exit.

7. When the Enter new job description name dialog appears, enter an appropriate name and click
OK. Your Job description is complete and automatically saved.

Check and activate the invoice profile

You have now completed the invoice profile, and it is time to activate it. It must be active for you to be able
to use it for processing invoices.

1. Make sure the invoice profile is open. An open invoice profile has a white icon. A closed invoice
profile’s icon is gray. If the invoice profile is closed, right-click the invoice profile and select Open to

make it editable.
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2. Right-click the profile again and select Settings. Invoices checks the validity of your invoice profile
and displays the results in a dialog. If you followed the instructions above, the dialog now indicates
that the invoice profile has no errors.

Note that Invoices cannot check for logical errors. You must ensure, for example, that any tables
used in the invoice profile are correctly defined and that the transaction layout suits your purposes.

Invoice profile - GBR-GE 5]
- General Activation:
- Identification .
Active
- Currency
- Supplier @ Inactive
--Learning invoices FR—
- Character set puntry:
- Events Great Britain (GBR)
-~ Advanced Invoice type:
Purchase order -
Version:
6.1
Changed:
11/27/2013
Status:
The invoice profile is OK. r

[ (014 l| Cancel |

The Invoice profile dialog with a status warning
If any errors are listed in the dialog, correct them, then check the invoice profile again.

3. Click Active to lock the invoice profile in the database. If there are errors listed in the dialog, Invoices
does not allow you to activate the invoice profile.

4. Click OK to close the Invoice profile settings dialog.

Right-click the invoice profile and select Save.

6. Right-click the invoice profile again, and select Close to close the invoice profile.
The invoice profile is now complete and ready for use in other modules.

i

Define inbox settings

The inbox is a way of choosing which invoices to verify. It is an alternative to running Verify jobs. The
inbox gives both Invoices administrators and Verify operators more control over the verification process.
Administrators can create customizable, hierarchical folder views that organize the invoices to be verified
in a way that is meaningful to their own production system. The folder view can be directed to Invoices
users based on their authorization rights and the invoices can be grouped and filtered according to a
variety of criteria such as:

* Invoice profile
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* Invoice status

* Buyer

» User-defined variables
* Queue

Before Verify operators can take advantage of the inbox feature, an administrator must create an inbox

folder view. To do this:

1. Select Inbox configuration from the Settings menu in Manager to display the Inbox configuration

dialog.

2 Inbox configuration
General settings

[] Show job descriptions in Verify

Columns

Configure which columns are to be available in
the invoice selection list. These settings apply
to all folders.

Folders

Specify which folders are to be available in the
selection tree.

Werify field order
Specify the arder in which fields are displayed
in the Verify module.

Users

Specify which users have access to specific
folders. Each folder can be connected to a
role’, which may be connected to many users.

[
Edit columns. ..
Edit folders...
Edit Verify field arder...
Edit roles and users... ]
| oK || cemeul |

Use the general settings to toggle job descriptions in Verify.

2. Click Edit folders to display the Edit folders dialog. This is where you can create a folder view for

the Verify operators.
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3. Click Auto-create folder structure to make a folder view that uses all of the invoice profiles. You
can create a folder view from scratch, however, we recommend using the Auto-create button as a

foundation.
Auto-create =]
(=BT Your Comparry DEL
......... [T|GBRGE
......... [C|GER-PO
......... [V]GER-PO
=J-{¥] Your Company GER
......... [T|GERGE
......... [V|GER-FO
......... [V]GER-FO
=¥ Unknown buyer
--------- [VIGBRGE
--------- [VIGBR-PO
......... GEH_PO
-------- Unlenown courtry
|| Uncertain separation
| Selectall || Selectnone | | Creste || Cancel

The Unknown buyer folder contains all of the invoice profiles.

4. For this tutorial, we want invoices from England to be displayed in the folder for Your Company
GBR and we want invoices from Germany to be displayed in the folder for Your Company GER.
Therefore, you need to deselect the GBR-GE and GBR-PO invoice profiles under Your Company
GER. Likewise, you need to deselect the GER-PO invoice profile under Your Company GBR.
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5. Click Create after you are finished making your selections to return to the Edit folders dialog. The
folder view appears in the Edit folders dialog.

! Edit inbox folders (mE3a)
Selection hierarchy: User authorization role [(None> V]
-] Your Company DEU
-] Your Company GBR V| Apply selection criteria to this folder/grou
b TR Apply Igroup
-l GBRFO Invoice prefiles | Siatuses | Buyers | Queues | Userdefined variable |
-+ GER-PO
Unknown buyer [7] <SYSTEM>
b [V] GBR-GE
-+ GBRGE VIEEES
W GBR-PO [ GER-PO
-§+ GERPO
Unknown courtry
tefy Uncertain separation
Verify options
Verify mode: [ Reinterpret
[ﬂdjust and approve '] [F1] Reverify
@ [ Auto-create folder structure ] [ oK ] [ Cancel ]

You can define criteria for each folder using the Edit inbox folders dialog.

Each item under a folder is a conceptual representation of the invoices that will be displayed when
you double-click that item in Verify. For example, if you select GBR-GE under the Your Company
GBR folder, you can see that the GBR-GE invoice profile is selected in the Apply selection criteria
to this folder/group. This means that when you double-click the same item in Verify, only invoices
that have been interpreted using the GBR-GE invoice profile will be displayed.

Each item you define in the Apply selection criteria to this folder/group creates a condition that
must be true in order to display an invoice in the currently selected item. As you become more
familiar with Invoices, you can use the buttons (Add root, Add child, etc.) at the bottom of the Edit
folders dialog to create folders of your own. You can also use the Edit roles and users button
(Inbox configuration dialog) to add another level of criteria to your inbox, by only allowing specific
users access to inbox folders.

6. Click Save to save your settings. You now have a fully functional inbox that will be displayed in Verify.

Test the invoice profile

Normally, before you begin using Invoices to process invoices with a particular invoice profile, it is
essential that you take the time to test the invoice profile. Your tests reveal adjustments you can make
which will increase Invoices’ interpretation rate.

To test an invoice profile, use the invoice profile in production (see Chapter 4) with some representative
test invoices, checking the statistics as you work and comparing the actual invoices with the transfer file.
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Define several additional invoice profiles with different settings and validation routines to determine which
works best for the invoices.

Follow these instructions to create a new invoice profile based on an already existing one:
1. Click the invoice profile that already exists.

2. Select Save as on the File menu.

3. Type a new name and click OK to save.

4. Right-click the new invoice profile and select Settings.

5. Change the invoice profile status to Inactive. Note that if the original invoice profile was closed

when you created the new one from it, the new invoice profile will also be closed when you save it.
Consequently, you need to right-click it and select Open before you can inactivate it.

Now you can make any changes you wish in the new invoice profile. You must reactivate, close, and
resave it before you can use it.

Other important activities

Although the activities described below are part of invoice administration, they are not usually performed
until after a first run through production. If you are using Invoices for the first time, we recommend that you
simply read them before you move on to the next chapter and then return to them later.

Skip the Scan module during testing

When you are testing Invoices, you can choose to have Invoices interpret invoices from image files
instead of scanning the invoices manually. Then, you can interpret them repeatedly, skipping the step of
rescanning the invoices for each test.

1. Double-click the job description to open it.
2. Select Source from the Interpret settings.

56



Kofax ReadSoft Invoices User's Guide

3. Select Import image files and click Configure.

Job description

===

¢ General - Invoice source

5 Sean ) Internal
@) Import im
~) Data sour

m

Conf

e St This =4
e Control Interpry
o Evierits i Choosd
- INWOI]
t T r

Configure image file source and destinations
General

Files of type:

-
. -

Advanced = I

Scanner description:
Image scanning DPI:
300 -

[] Always show configuration dialog
Source directory:

CANV_production

Maove files

|dentified:
C:AINV_production®dent
Error:

C:AINV_productionEmar

Log file
[] Save log file

og file name:

If log exists:

-

] I Cancel J

You can skip the Scan module by

4. Select “*.*” in the Files of type box to import all supported image file types, or select a specific file

importing image files.

type, if you know what type of image files you use.

5. When the Configure image file source and destinations dialog appears, click the folder button
next to Source directory in the General group box, and specify the folder where your images are

located.

Default paths for Identified and Error files automatically appear in the Move files dialog.

6. Click OK to exit the Configure image file and destinations dialog, then click OK again to save your

changes and exit the dialog.

57



Kofax ReadSoft Invoices User's Guide

7. Run the Interpret module and start the interpret job. Invoices moves the image files from the main
folder you selected to the various subfolders, depending on whether or not Interpret processed them
successfully. Normally, they are moved to the Ident folder.

=l | ) ReadSaft
= [ INWOICES
+ () Bin
| ColorImg
+ | ) Counkry Profiles
|2 Documentation
|Z) Evmap
= O
| Error
| Ident
I Temp
The folder structure for your image files can look something like this.

8. To reuse the files to test the system again, use Windows Explorer to move them from the destination
folder (usually Ident) back to the source folder.

Test the transaction description

The result of processing invoices with Invoices is the information output from those invoices. "Test the
invoice profile” on page 55 describes one way you can optimize the accuracy of that information.

The content and format of the output is also important. Testing the transaction description can reveal
adjustments that you can make which result in an output format best suited for the target system using the
transfer file.

To test a transaction description, you must repeatedly run invoices in Transfer, checking the transfer file
after each Transfer job to evaluate the results. This process is rather time-consuming since you must
interpret, verify, and transfer test TIFF files each time, but it is worthwhile to fine-tune the content and
format of your output.

Customize job descriptions

Before you begin using the application to process invoices, it is worthwhile to think about your alternatives
for the job descriptions for the four production modules. By trying different settings, you can customize
Invoices to your needs and make the verification process very efficient.

Do not hesitate to define a number of job descriptions with different settings to see which ones work best
with different invoice profiles or for different users. Follow these instructions to base a new job description
on an already existing one, using the Manager or any of the production modules:

1. Select a job description you already created.

Select Save as from the File menu.

In the Save job description dialog, type a new name.

Open the new job description you just created and make any changes you choose.
Click OK to close the dialog.

Al o
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6. Click Save.
If you want to try various settings for an existing job description while working in one of the
production modules, there is no need to save changes at all. Although an edited job description is
not saved to a file, the changes are still active and you can select Start (Job menu) to use the job
description with its changes.
You can always change your mind about not saving a new job description and select Save or Save
as on the File menu. If you close the module without doing so, the changes are permanently lost.

Before you begin: What to think about

Before you begin creating your own invoice profile, look at some of the invoice types you plan to capture
in Invoices.

Some characteristics of the invoices that are important to take note of are listed below:

» Paper size. What size is the paper that the invoices are printed on? This information must be specified
in the scanner description.

* Fields. What information do you want to capture from the invoices? Think of which fields you need and
what formats they use. Avoid using titles that are not unique. Specifying unique titles saves production
time and increases interpretation rates.

» lIdentifiers. Decide what will be used as the identifier. The identifier needs to contain either a piece of
information or an image that is included on every invoice and is unique for each supplier. If not all of
the invoices contain the same piece of information, you can use multiple identifiers, for example, one
identifier for account numbers and one for logos. Each invoice profile can contain up to three identifiers
in any combination.
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Chapter 4

Production

Chapter 3 described the basic steps involved in preparing Invoices to process your invoices. This chapter
describes the actual invoice processing or production.

Scan, Interpret, Verify, and Transfer work only in accordance with job descriptions. Your first step in these
four modules is always either to open an existing job description or create a new one. Note, however, that
both Interpret and Transfer can be run automatically as Windows Services. See Invoices Help for more
information about automating Interpret and Transfer.

"Production” While all administration tasks are performed in the Manager, your incoming invoices are
processed using the four production modules:

1. Scan: scanning invoices
2. Interpret: interpreting and validating invoices
3. Verify: verifying and approving invoices
4. Transfer: transferring information from processed invoices
All phases can be performed on a single computer or different computers (if they share databases).

Scan operator tasks

In this section, we use the invoice profiles set up in Chapter 3.

Step 1 - Start the Scan module

1. Switch on the scanner before you turn your computer on. Otherwise, your computer’s device driver
may not find the scanner.

2. Start the Scan module from the program group created during installation or run the program
eiscan.exe.

Step 2 - Scan the invoices

The sample invoices images included with the program can be printed and then scanned and used in
production (or they can be imported directly).
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1. Place the invoices in the document feeder as straight as possible.
2. Select File > Open menu) or click Open on the toolbar.

3. When the Select job description dialog appears, select the job description you want to run, and
click OK.

4. Click Run to begin the job.

Invoices starts the scanner and begins receiving images of invoices. The job status, date, and time
are displayed on the screen while the scanner is running, as well as a bar chart indicating how many
invoices of each type have been scanned.

If you are running your invoices in batches with a fixed number of invoices, Invoices runs until the
specified number of invoices has been scanned. If not, Invoices runs until the scanner’s document
feeder is empty.

You can stop at any time by stopping the scanner manually.
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5. When the document feeder is empty or when the batch is finished, you can add more invoices and
continue the job by clicking Continue in the Operator control dialog, or you can click Stop to stop
scanning.

= Scan - INVOICES 5 - [GBR-PO] - = X

& File View Help =X

J ir @

=
=

Operator control =2

Message

The automatic document feeder is emply.

Rescan Mew batch | | Delete batch

| Ready | cAP| NUM| SCRL g3 |

The Operator control dialog notifies you when the document feeder is empty.

As invoices are scanned, they are saved to Invoices’s database automatically unless you specifically
discard them. This is why there is no Save or Save as command for scanned invoices in Scan.

Thumbnail images of the most recently scanned invoices appear as the invoices are scanned. To
view an enlarged invoice image in another window, right-click the thumbnail image and select View.

Certain events (some of which are described below) may require your attention during scanning. A
message displayed in the Operator control dialog describes the situation.

Scanning invoices in batches

If you are scanning invoices in batches, you are given the opportunity to enter batch information before
each new batch begins.

If you indicated in the job that you wanted to confirm each batch, then after each batch is finished, you
must select New batch, Continue, or Stop before the Interpret module can begin to process the scanned
images.

For additional information about batches, refer to /nvoices Help.

Problem: The scanner needs attention

« If the scanner is not connected or is switched off, connect or switch on the scanner, wait until it is ready,
make sure there are invoices in the document feeder, and start the job again.

« If the document feeder is empty, add more invoices and restart the job.
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If a paper jam occurs, clear the paper path, clear the error status on the scanner (refer to the scanner’s
manual), and restart the process.

Step 3 - Close the Scan job

Once the Scan job has finished running, close the Scan module by choosing the File > Exit menu.

Yo

u are now ready to move on to Interpret.

Interpret operator tasks

Th

Yo

e Interpret module:
Learns the new invoices as completely as possible without manual assistance.
Creates an invoice definition for each new invoice type.

Captures the information on the invoices (for new invoices, it captures information for the fields it can
learn).

u can run Interpret with a graphical interface, as described in the next section, or you can run Interpret

automatically using Windows Services. Services start and stop automatically according to the times you
specify, and they can run indefinitely without interaction. See Invoices Help for more information on using

Wi

ndows Services.

Step 1 - Run the Interpret job

1.

d

Start the Interpret module from the program group created during installation or run the program
eiitrp.exe.

Select the File > Open menu option or click Open on the toolbar.
Select the job description you want to run and click OK.
Click Start to begin the job.

The Statistics box is displayed and updated after each invoice is processed. The job status, date,
and time are displayed, as well as a bar chart indicating how many invoices have been interpreted.
There are no operator dialogs that require your attention.

Depending on the speed of your workstation, this can take some time.

Status RUNNING 10
Start date 11423/2M 3
Start time 10:15:50 AM
Elapsed 00:00:13
|rwoices processed 3 I
1]
Irvoices

Information about the Interpret job is displayed and automatically updated while the module is
running.
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5. When all the invoices are processed, a message at the bottom of the window tells you there are no
more invoices.

6. You can view statistics, which tell you how many invoices were interpreted, when they were
interpreted, and how long it took by choosing the File > Statistics menu option.

You can save statistics from the latest run by clicking Save in the dialog. When you have saved
statistics, you can also print them.

7. When the job is finished, select File > Exit to close Interpret.
You are ready to move on to Verify.

Verify operator tasks

After the invoices have been processed by Interpret, they are ready for verification. Any fields on an
invoice that were not fully captured by interpret are presented for adjustment. You are asked to verify
the invoices to check that the interpreted values for each field are correct and change them if they are
incorrect.

Step 1 - Start Verify

1. Start the Verify module from the program group created during installation or run the program
eiveri.exe.

N Verify - INVOICES 5 - [Your Company GBR / GBR-GE] - = X
[ File View Help o
BoTHIP

Inbox
-qj Your Company DEU
i+ GER-PO D Supplier ScanTime Endorser
— our Company GBR (4) 1 Bilgor Devices 11/29/2013 10:15 AM

o GBR-GE (4) 3 Bilgor Devices 11/29/2013 10:15 AM
| e GBR-PO 5 ML Industries 11/20/2013 10:15 AM
-] Unknown buyer
: + Unknown country 7 ML Industries 11/29/2013 10:16 AM
@ Inbox
# Job results
= ] m 5
=1 Inbox

» [ Select all ] I Start
| Ready CAP| NUM| 5CRL| Lz |

Use the inbox to decide which invoices you want to Verify.
2. Expand the folders in the inbox so you can see which invoices you want to verify.

You can double-click an item under a folder to see what invoices are listed there. For example, if
you double-click GB-PO, you only see invoices that have been automatically classified as purchase
orders for Great Britain.
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3. Select the invoices you want to verify.

To select individual invoices you can hold down the SHIFT key or CTRL and click each desired
invoice definition. Alternatively, you can click Select all to choose all of the invoices.

4. Click Start when you are ready to begin verifying.

Step 2 - Verifying the invoices

Verify displays all the invoices that have been interpreted for verification according to the criteria set by
the inbox. You use Verify to check buyer and supplier information and to make sure that all fields are
interpreted correctly.
1. Check that the buyer and supplier information are correct. You can use the Buyer and Supplier
boxes to change this information if necessary. You can also click Supplier number to view more
detailed information about the supplier for comparison.

Buyer:
) 1 Your Company GBR -
Supplier: Description:
@ MLIndustries
»  Debit/Credt @ |Debit ™
InvoiceNumber 510870
InvoiceDate @ | 30112013
OrderMumber @ | 0047600
DeliveryNote @
NetValue ® (416648
VATRate ® (1750%
VAT Value ® (72513
DeliveryCost 0.00
GrossValue ® (485561
Cumrency ] IGBP -
VATReg ® 123456789

The Verifying dialog displays the interpreted fields.
2. Check that the field values are correct.

Option
e ...means Invoices thinks the field has been
= interpreted correctly.
...means the field needs your attention.
@ ...means there is something wrong with the field.

Each field has an image that indicates its status.
Click in any value box to see the corresponding field’s location on the invoice image.

Click the button in the # column to scroll through the proposed field values. Only one proposal for
each field should be correct. Once you have found the correct field on the invoice, check that the
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interpreted title and value are correct. If necessary, you can retype the values directly into the edit

boxes. When you find the correct proposal, press Enter.

If Invoices cannot find a field, locate the field on the invoice yourself and double-click it. Invoices will
automatically interpret the value for you. If necessary, you can type the correct value in the edit box

instead.

3. After you check that all the interpreted values are correct, click OK. This means that you have
verified the invoice and accept the values.

Now the first invoice is completely processed by Verify, and the information is ready to be transferred

to your financial system. You transfer the information later by following the steps in the next section.

After you click OK in the Verify dialog, Verify starts processing the next invoice.
4. Continue this process until all the invoices are verified.

Verify toolbar

There are other actions you can perform on invoices in Verify. The Verify toolbar contains the most
common commands you use.

v]

Approve. Click this button after you have ensured that all the invoice information is correct. This is the
same as clicking the green OK button.

&2

Credit/Debit. Click this button to change an invoice to a credit note, or vice versa. This is the same as
selecting Credit or Debit from the Debit/Credit field.

Reject. Click this button if you do not accept the invoice for any reason. You can click this button, for
example, if the document you are verifying appears to have been scanned by accident and does not
belong in the system at all.

Reroute. Click this button to change the buyer of the invoice or to change the invoice profile that was
used to interpret the current invoice.

Reinterprets the current invoice. Click this button to reinterpret the current invoice.

User remark. Click this button to add a remark, or message, to an invoice. User remarks are saved in
the process log. See Invoices Help for more information about process logs.

Step 3 - Exit Verify

1. After you have verified the last invoice, click OK in the No more invoices dialog.

You can view statistics that tell you how many invoices were verified, when they were verified, and

how long it took by choosing the File > Statistics menu.
2. When you are finished, close Verify by choosing the File > Exit menu.
You are now ready to transfer information.
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Transfer operator tasks

After all the invoices are verified, they are ready for transfer to your financial system or to other systems.
Once the Transfer module is finished with the invoices, a complete transaction, in the format defined in the
invoice profile, is available in a file.

You can run Transfer with a graphical interface, as described in the next section, or you can run Transfer
automatically using Windows Services. Services start and stop automatically according to the times you
specify, and they can run indefinitely without interaction. See Invoices Help for more information on using
Windows Services.

Step 1 - Run the Transfer job

During transfer, job status, date and time are displayed, as well as a bar chart indicating how many
invoices of each type have been transferred. There are no operator dialogs that require your attention.

Status RUNNING 10
Start date 114292013

Start time 10:15:50 &M

Elapzed 00oo:13

Invoices processed 3 I
]

Invoices

Information about the Transfer job is displayed and automatically updated while the module is running.

1.

d

Start the Transfer module from the program group created during installation or run the program
eitran.exe.

Select the File > Open menu, or click Open on the toolbar.
Select the job description you want to use and click OK.

Click Start > to begin the job. Invoices runs until all invoices with the specified statuses have been
transferred to the file specified in your Transfer job description. The format of the output information
is determined by the transaction description linked to the invoice profile.

Step 2 - Exit Transfer

1.

2.

When the job is finished, you can view statistics which tell you how many invoices were transferred,
when they were transferred and how long it took by choosing the File > Statistics menu.

You can save statistics from the latest run by clicking Save in the dialog. After you have saved
statistics, you can also print them.

If you do not save statistics, Invoices prompts you to do so when you exit Transfer. However, you can
click No if statistics are of no interest.

When you are finished, close Transfer by choosing File > Exit.
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3. Once the information has been transferred to a file, you can open and examine the text file with a
text-editing program such as Notepad. If you used the predefined settings in Eilocal.ini, the transfer
file can be found in the INVOICES\Transfer folder.

The sample invoices have now gone through the entire production process. To begin using your
own invoices, create a new invoice profile, transaction description, and job descriptions. Then, run
your invoices through the production process. Refer to this guide for help. For assistance with more
advanced functions, refer to Invoices Help.
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Optimize production

When new invoice definitions are created during production, they are based on an invoice profile, which
is designed to capture a wide variety of invoices from many suppliers. An invoice that does not fit the
general model of the invoice profile, can have repeated field errors or identification problems. To resolve
this, you can use the Optimize module to provide more detailed information about the invoice definition.
This improves interpretation success and increases production.

Not all invoices with poor interpretation need to be optimized. Before optimizing an invoice, consider
how often the supplier sends you invoices. If you rarely receive invoices from this particular supplier,
optimization is probably not worthwhile. On the other hand, if you receive numerous invoices from this
supplier on a regular basis, you can benefit from the increased performance of an optimized invoice
definition.

Manually learning invoice definitions

During manual learning, Optimize displays the invoice definition image, so you can help Invoices learn it,
and updates the invoice definitions according to your manual input about field positions and properties.

In addition, during manual learning, Optimize captures any information on the invoice definition that was
not captured by Interpret.

Step 1 - Start the Optimize module

1. Start the Optimize module from the program group created during installation or run the program
eiopti.exe.
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2. Double-click the invoice profile that contains the invoice definitions you want to optimize. Optimize
produces a list of all the profile’s invoice definitions with information about their statuses and other
statistics in the Invoice definitions dialog.

@ Optimize - INVOICES 5 - [Invoice definitions - [ GER-PO 1] - = Xx
P& File View Help _mx
i 2| t=@+2 XL >ONasc0B0MA] | 2 [Tt 10|

@ Created

(7} Changed

Created: YYYYMMDD YYTYMMDD FEER S s

[a 2 | || | S

Rows: 2

"GER-PO"
jin] Invoice profie Corparate group ID Supplier number Supplier Location Description Optimize

GBR-PO 1 1234567 ML Industries a

11

1 LI} 13

Ready [ cap| muM]| scre| ;|

The Invoice definitions dialog contains statistical information about the invoice definitions.

Step 2 - Select which invoice definitions to optimize

You can choose to optimize single invoice definitions separately or an entire group of invoices in an
optimize session. :

To optimize a single invoice definition, double-click the invoice definition name in the Invoice definitions
dialog.

To optimize a group of invoices based on their status:
1. Select File > Optimize.
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2. When the Optimize session dialog appears, select which invoice profile you want to optimize.

Optimize session @
Invaoice

GER-FO -

Selection

All knowen

All learned

| Update invoices

[ Ok ] | Cancel |

The Optimize session dialog allows you to select which invoice profile definitions you want to
optimize.
3. In the Selection group box, select which invoice definitions you want to optimize according to their

status (that is, All unknown, All known, or All learned). In most cases, you want to optimize All
unknown invoice definitions.

4. Click OK to begin the manual learning of the invoice definitions.

Step 3 - Manually learning fields

After you select which invoice definitions to optimize, the Learning and Field learning dialogs appear
together with the invoice image. Depending on what information is needed, either the supplier, the
description, or the first field that is Not learned is activated.

The Learning dialog lists all the fields that are defined in your invoice profile, the type and status of each
field in the invoice definition and the invoice definition status. Note that the Not learned fields require
manual learning. This dialog changes as you learn each field. When all the fields on an invoice definition
are Learned, the invoice definition is also Learned.
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Supplier:
ML Industries

Description:

Close

Supplier number:

Skip

1234567
Status: Type:
Known Paper Settings
Data objects:
Name Type Status i
"_'Jl VATReg Value identifier Learned
'-_gl Logo Image identifier Learned
'-_gl Telephon... Value identifier Learned E
Eﬂ Buyer Buyer Mot learned
;.’_g] Debit/Cr... Single item field Mot learned
;__EI InvoiceM... Single item field Learned
;__EI InvoiceD... Single item field Learned
;__EI OrderMu... Single item field Learned
;__EI Delivery... Single item field Mot learned
;__EI MetValue Single item field Learned -
4 T 3

The Learning dialog shows the status of the fields in the invoice definition.

Not learned fields often contain field proposals, which are fields Invoices has found that may or may not
be correct.

Occasionally, a Not learned field may not contain any field proposals. This means that Invoices could
not find any fields with the characteristics specified in the invoice profile. This is often caused by the field
having a dark background, in which case you need to apply a background filter, or by the field’s text being

hard to interpret (bold text, matrix-printed text, etc.), in which case you can change the text type in the
Field learning dialog.

The active field (the title and value fields currently being learned) is highlighted in the Learning dialog, and

Invoices’ interpretation of the field is presented in the Title and Value group boxes in the Field learning
dialog.
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B Optimize - INVOICES 5 - [GBR-PO - ML Industries]

File View Invoice definition Figld Help

[l |Fine-grained - 123 (e | J | J & =

~ E|
Supplier:
|ML Industries Approve
Drescription:
i _ e |
Supplier number: Skip
Status: Tupe:
|Known | Mormal Settings
[rata objects:

Status Field propozal |

ate  Single item Learned
E Metalue Single item field Learned
E WATRate Single item field Learned
E WATWalue  Single item field Learned
E Gross¥alue  Single item field Learned
E Currency Single item field Learned
E OrderMurn...  Single item field Learned

21-09-2004

Invoice No 510870

Walue Title:

VAT REG No 123456789 sz || oo e

Bemave

[DDMMY Y |date
| Default ﬂ | Default j
GBR M

Order Number 0047600

Move

Fosition

= O

c 1 v »

y GBR
et

Option Advanced...
I¥ First page

antity | Unit Price | Amount | ™ Lastpage
4

R [ Dptional
‘( I 4CN EN | 4EN En | 5 | e

= ™ Supplier field
Page 1 Lancel

Ll 1

Ready LM

The Learning and Field learning dialogs with the active field marked on the invoice image

1. Click the name of a Learned field in the Learning dialog.

If you cannot see the field marked on the invoice image, change the invoice size or position until you
see the field title and value outlined on the invoice.

2. Check that the correct title and value are outlined, then look at the Field learning dialog and check
that the interpreted title and value match those printed on the invoice. If you choose, you can double-
check all Learned fields in this manner.

3. When learning a new invoice type, try to determine whether the Position of each field type varies
from invoice to invoice or is always in the same place. In the Position group box in the Field
learning dialog, you can change the row and column position of the field from variable to fixed and
vice versa. Whenever possible, we recommend that you set a field’s position as fixed, because fixed
fields are easier for Invoices to find than variable fields.

Note that the position selections you made in the field profile act as default selections when you learn
a field for the first time.
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4. After you have double-checked a Learned field and set its Position, click OK. This saves your work
and updates the field definition for the field.

t_Making adjustments

5. After you have checked all the Learned fields on the first invoice, select the first Not learned field in
the Learning dialog.

If there are no proposals for a Not learned field, you may need to change the text type or apply
a background filter. See the heading "Applying a background filter” at the end of this section for
instructions.

In the Value group box, you can change the value format specification in the second box. For
example, if you know that the account number from a certain supplier always has eight digits, you
can specify the format as N(8) rather than N(6-13), making the field easier for Invoices to find on
future invoices. We recommend that you make the format as specific as possible for each field
definition.

The first box in the Title group contains the title that will be associated with the field when you click
OK to exit the dialog. The gray box beneath it shows the exact interpretation results. When Invoices
interprets a title, these results are usually copied into the box above. However, if the interpretation
results are similar to an existing title, the existing title is used instead. Click the gray box with the
interpretation results to copy them into the box. The title shown in the first box can also be chosen in
the selection box from the list of existing titles, or it can be typed manually.

In the Title group box (the first selection box containing the list of possible titles) there is an
alternative called No title. However, we recommend that you do not use this alternative. Instead,
learn the title field if it exists, even if the field has a fixed position, because if Invoices does not find
the value for a fixed-position field based on its position, it searches again with the help of the existing
title. If you provide a title, you can therefore save some time and reduce the amount of necessary
learning.

6. Once the Field learning dialog displays the correctly interpreted value and title (unless you
select No title) and you are satisfied with the settings, click OK to save the information to the field
definition.

As you can see in the Learning dialog, the field is now Learned.
7. Continue with the next Not learned field until all field definitions are learned.

8. After you finish learning the Not learned fields, enter the name of the supplier in the Supplier box.
This will also be the name of the invoice definition.

You use the Description box if a supplier has more than one invoice definition sharing the same
identifier. See Invoices Help for more information.

9. Once the invoice definition is named, click OK to complete the manual learning process.

Select the text type

Text type in fields” You can specify whether or not the field title and value were printed in bold type, as well
as whether or not they were printed on a dot-matrix printer or written by hand. The default values for all
invoices are not in bold type and not printed on a matrix printer or written by hand.

If you are using the sample invoices, make sure the Text type selection boxes are set to Default. The Text
type selection boxes are located in the Value and Title group boxes in the Field learning dialog.
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Drawing frames

Occasionally, you may want to mark a field directly on the invoice image for Invoices to interpret. For
example, if you want to capture a specific date on an invoice that contains many different date fields, you
may need to show Invoices which one is the correct one.

1.
2.
3.

Select the field you want to modify in the Learning dialog.
On the invoice image, click the frame you want to redraw and click Remove to delete it.

Click the toolbar button (Identifier, Value field, Title field) that corresponds to the type of frame you
want to draw.

Draw a box around the area you want to learn.

[Tnvoice no: 9724618
Invoice Date: 03.C§.9?

There are three ways to draw a box:
» Double-clicking the field causes the box to snap to the field.
+ Clicking and dragging a box around the field also causes the box to snap to the field.

» Clicking and dragging a box around the field while holding down the Ctrl key prevents the box
from snapping to the field. This is helpful if you want to specify a search area larger than the
current field.

Optimize automatically interprets the results and displays them in the Field learning dialog.

Make the necessary adjustments, such as applying a background filter or changing the text type, to
achieve the correct interpretation.

When you have achieved the desired result, click OK in the Field learning dialog to save the field
definition.

Applying a background filter

This section is only intended for use with Not learned fields that have dark or patterned backgrounds.

If the invoice you are verifying has one or more Not learned fields with no field proposals, you may need to
apply a background filter. Look at the field in question on the invoice image. If the field title or value has a
dark or patterned background, try filtering the background. Invoices uses a variety of filters to screen out
the background of a field in order to read the text more clearly.

Note: For identifiers, only use a filter if it is required for correct interpretation. Filtering identifiers increases
the time required to interpret invoices.

In this section, we use the amount field from one of the sample invoices to demonstrate the filtering
process. You can apply the same process to any field that requires filtering.

1.

Find the field to be filtered on the invoice image. Enlarge the image a few times by clicking Zoom in
until you can see the area well.
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2. Click Filter and use the mouse pointer to click and drag a box around the field, leaving a little extra
space around the edges.

AMOUNT
124369
Use the mouse to draw a frame around the area to be filtered.

3. Select afilter type from the Filter selection box. The field is reinterpreted automatically.

4. If Invoices still could not interpret the value, try a different filter type. Click the arrow in the Filter
selection box and select a new filter type. Invoices applies the new background filter automatically.

& Optimize - INVOICES 5 - [GBR-PO - ML Industries]

File Wiew Invoice definition Figld Help

& |Cuarse—grained j ETL
Fine-grained '
Coarse-grained
Pattern

Invert
Despeckle
Erase

Filter options in the Filter selection box

5. Repeat this procedure, trying new filter types, until you find the background filter that works best. You
can also use various combinations of two or more filters to obtain the desired results.

Occasionally, image quality is too poor to be corrected by filters. If this happens, select the
background filter that creates the cleanest image and type the value manually into the Value group
box.
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Quick notes

Commonly used keyboard shortcuts

= = | linvoicesHelp

'
|

= = | Scale image (normal) (Manager, Verify and Optimize)

= | Zoom in (enlarge) (Manager, Verify and Optimize)

=]
98]

= | Zoom out (reduce) (Manager, Verify and Optimize)

-
~

= | New single item field profile (Manager)

=]

= | Edit field profile (Manager)

gy
(@)

= | Delete field profile (Manager)

= New value identifier profile (Manager)

g5

= | First invoice definition (Manager)
Home

GENEIERERENE

= | Last invoice definition (Manager)

End
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Next invoice definition (Manager)

.3 .y
© <
S S

Previous invoice definition (Manager)

Exit
Add user remark (Verify)
Delete invoice (Verify)
Skip invoice (Verify)
Alt F10
Previous invoice (Verify)
Alt BkSp
# Previous field proposal (Verify)
Alt Also returns focus to the current field when you toggle back to Verify from
another program.
# Next field proposal (Verify)
Alt Also returns focus to the current field when you toggle back to Verify from

another program.

Shift

g

Tab

Previous field (Verify)

Tab

Next field (Verify)

Enter

d

Next field error/Complete field (Verify)
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Start job (Scan, Interpret, Verify and Transfer)

Ctrl

Alt S l
Stop job (Interpret, Verify and Transfer)
Alt T l
Pause job (Interpret, Verify and Transfer)
Alt P I
Continue job (Interpret, Verify and Transfer)
Alt C l
é

Scroll image up (Manager, Scan Verify, and Optimize)

Ctrl

(08

Scroll image down (Manager, Scan Verify, and Optimize)

Ctrl

H*

Scroll image left (Manager, Scan Verify, and Optimize)

Ctrl

H*

Scroll image right (Manager, Scan Verify, and Optimize)

Ctrl

New job description

Ctrl

Open job description

Ctrl

Save job description

Ctrl

WU

Edit job description
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+ = | Print the selected object

Ctrl

= | Enable/disable grayscale (Manager and Verify)
Ctrl

= | Delete highlighted frame during learning (Verify)
Ctrl

ElfaNa
w@w

Numeric keypad shortcuts

+ = | Zooms in the Verifying dialog (Verify)
Ctrl

= | Zooms out the Verifying dialog (Verify)
Ctrl

= | Resizes the invoice image to fit the window (Verify and Optimize)
Ctrl

L e

= | Zooms in the lower left corner of the invoice image (Verify and Optimize)
Ctrl

= | Zooms in the lower right corner of the invoice image (Verify and Optimize)
Ctrl

= | Zooms in the upper left corner of the invoice image (Verify and Optimize)
Ctrl

= | Zooms in the upper right corner of the invoice image (Verify and Optimize)

Ctrl

a

= | Zooms in the center of the invoice image(Verify and Optimize)
Ctrl

g
CooObODOOUOUOD
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+ = | Toggles the invoice image between black and white and color.
=) 0

Steps to prepare for production

1.
2.
3.

© o N>

Define user authorization settings (required)

Import master data from your financial system and adjust the master data policy (recommended)
Create an invoice profile for each legal entity (required)

» Adjust, add, or delete identifier profiles

+ Adjust, add, or delete field profiles

Add a standard transaction description and mark it as default (required for each invoice profile)
+ Determine the physical layout of the output

» Set the default transaction description

Create a scanner description (required if using a scanner)

Create a job description (required)

Check and activate the invoice profile (required)

Define inbox settings (recommended)

Test the invoice profile (recommended)

Format specification

Symbol Meaning Examples
Syntax: N(7)
N Numeric characters Meaning: | A 7-digit numeric field
Field: 1234567
Syntax: A(2-5)
A Alphabetic characters Meaning: | An alphabetic field containing 2 to 5 characters
Field: Abc
Syntax: X(5)
X ,:rl)p:::?;ucrﬁg:g:c;::rasrzﬁﬁrz:r:g“, ">" | Meaning: A field containing five characters, each of which can be a letter,
otc. number, or a special character
Field: Abc3D
Syntax: N(3)WN(2)
w White space Meaning: | A field containing 3 digits, a space, and 2 more digits
Field: 123 45
S Numbers with plus or minus signs | Syntax: SN(3)
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Symbol Meaning Examples
Meaning: | A three-digit, numeric field with a plus or minus sign in front of it
Field: -425
Syntax: N(4)-X[#]
Meaning: The character, #, is removed when this four-digit field is
- Remove characters before transfer transferred
Field: 1234#
OQutput: 1234
Syntax: N(1-5).NN
Decimal Meaning: A nl_Jmeric field containiqg_one to five digits followed by a
decimal and two more digits
Field: 24.99
Syntax: N(3)*N(5)
. Insignificant characters Meaning: g:;:(te: digits followed by an insignificant character and five more
Field: 123-45678
Syntax: N[*0]
A Exclude Meaning: | Any digit except zero
Field: 2
Syntax: A(5)
() Required Meaning: | The field must contain five alphabetic characters
Field: Abcde
Syntax: N[139]
[1 Specified sign Meaning: | A single digit that can be one, three or nine
Field: 3
Syntax: {N(5)IN(10)}
{} Multiple formats Meaning: | Either a five-digit field or a ten-digit field
Field: 12345
Syntax: {N(5)IN(10)}
The "or” operator used to separate |\ nino- | Either a five-digit field or a ten-digit field
multiple formats.
Field: 1234567890
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Chapter 7

Glossary

Action. What is done for a specific invoice rules when all conditions are true.
Add-on. An external application (usually a DLL) that adds functionality to Invoices via the API.

Appendix. A form or document which is attached to an invoice. Scan can process invoices with multiple
appendices. The information from an appendix is not processed, but is only saved as an image.

Batch. A stack of invoices that you process together in order to (1) set up a scheme for locating invoices
after archiving; (2) divide invoices into manageable quantities; and/or (3) summarize information from
each batch in order to check the integrity of the captured information. You can put as many invoices as
you like into the scanner’s document feeder’"Document feeder” and let Invoices count the invoices.

Batch report. A printout of information about a batch that has been processed. You can use Invoices’
standard batch report layout, or you can define your own batch report layout.

Buyer registry. A table containing information, imported from your financial system, that Invoices uses to
route invoices to the proper buyer or legal entity.

Check digit. Some numbers on invoices include a control digit that is based on the other digits in the
number. A checking routine performed on the number practically eliminates the risk that digits in the
number have been interpreted incorrectly.

Condition. A criteria that determines if actions are executed for a specific invoice rule when using the
Invoice Rules plugin. If a condition meets the specified criteria, it returns true; if not, it returns false.

Database. A collection of saved information that is administered in the Manager.

DCL. A data capture language that uses special expressions and business logic to capture fields. DCL
expressions are saved in DCL files and are connected to country profiles via Eiglobalextra.ini.

Deskew. Skew is the slanting of a scanned image caused when an invoice is not aligned properly as
it passes through the scanner. Kofax ReadSoft Invoices can normally deskew (that is, straighten) and
identify images of invoices that are skewed up to 10 degrees which handles most situations.

DLL. Dynamic Link Library is a collection of executable code. DLLs can be used to customize Invoices.

Dynamic value. A value that is evaluated at runtime depending on the current context in connection

with an action that is configured for an invoice rule in the Invoice Rules plugin. For example, a dynamic
value could be read from a specific invoice field where the result depends on the value of that field for the
current invoice being processed.

Entrance mode. A feature in ReadSoft Invoices that allows you to change the terminology in the program
interface to more generic terms when working with non-invoice documents (such as customer orders,
for example). This can be done separately for each user in the system (meaning that some users in
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your system can run the program for invoices while others can use entrance mode to handle generic
documents.

Endorser. A built-in printer in a scanner that prints a sequence number on each invoice and can be useful
for archiving purposes. Your scanner must support endorsing to utilize this feature.

Field. An area on an invoice which contains information to be interpreted and processed by Invoices.
Example: an invoice date.

Field definition. Information about where a field is located on invoices from a certain supplier and how to
use and interpret it.

Field name. A label given to each field profile. There is no limit to the number of characters a field name
can contain.

Field profile. The field profile tells Invoices how to look for a particular field when new invoices are
interpreted. It also tells Invoices how to use and interpret the field.

Format specification. (field format specification). A property that is specified for most field definitions and
profiles that describes how many and what type of characters are expected to appear in a field.

General expense (GE) invoice. Typically, an invoice used to bill individual business expenses. By
default, a general expense invoice does not include line items.

Identifier. A unique value or image used to recognize invoices. This field must appear on all invoices and
must have a unique value or image for each type of invoice to be processed.

Interpret. The Interpret module is used to automatically interpret and validate invoices that are either
scanned in the Scan module or put into the system in other supported file formats.

Invoice definition. Contains the exact positions and the field descriptions of the fields on a unique
invoice type that has a unique identifier value. An image of the invoice that was used when the invoice
definition was created is also part of the invoice definition. Each invoice definition is associated with the
invoice profile from which it originated. The invoice definition information is stored in the invoice definition
database, and the invoice definition images are stored in the image database.

Invoice profile. A general description of the information that you want to capture from a particular group
of invoices. The same invoice profile can be used for invoices from many different suppliers.

Invoice rule. A list of defined conditions, actions, and events used to perform different actions depending
on current conditions when using the Invoices Rules plugin.

Invoice type. An invoice with a unique identifier. Generally, all invoices from one supplier belong to the
same invoice type because they share the same identifier value, such as the supplier’s account number.
Each invoice type has a separate invoice definition.

Job. A task performed by a specific module on a specific group of invoices. The job is defined using a job
description. The Scan, Interpret, Verify and Transfer modules perform jobs.

Job description. A set of instructions describing what you want a specific Invoices module to do. It tells
the program which invoices you want to process, which module to use, and how you want Invoices to
work. The Scan, Interpret, Verify and Transfer modules are run using job descriptions, which can be
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created individually, in the modules themselves, or they can be created together in one job description
using the Manager module.

» Scan job description. Tells Scan how to process the invoices to be scanned.
* Interpret job description. Tells Interpret which invoices to interpret and validate.

» Verify job description. Tells Verify which invoices you want to verify according to status. You can
also choose from many options for how you want Invoices to interact with you during the verification
process.

» Transfer job description. Tells Transfer what information to transfer and where to transfer it.

Learning. An interactive process in the Verify and Optimize modules that occurs when the Interpret
module is not able to completely learn a new invoice definition or when existing invoice definitions need
more advanced learning in Optimize.

Verify displays an image of the new invoice definition and presents proposals for various fields. The user
then tells Verify which proposals are correct. Optimize allows you to draw fields manually, learn logo
identifiers and line items, and adjust detailed aspects of the invoice definition.

After the learning process is finished, the invoice itself is ready for verifying.

Maintenance plan. A plan you create using the Manager that specifies how maintenance is to be
performed on Invoices' database.

Manager. This module is used to administrate Invoices, that is, to create and manage invoice profiles,
invoice definitions, job descriptions, validation tables, and batch report layouts, among other things.

Master data. Supplier and buyer information imported from a financial system. Master data can be saved
in Invoices' database.

OCR engine. The OCR (Optical Character Recognition) engine is the part of the Invoices program code
that interprets invoices.

Purchase order (PO) invoice. A purchase order usually contains tables of line items of goods that were
purchased, and it must have the purchase order number printed on the invoice.

Record. Information resulting from one invoice.

Scan. The production module used to scan invoices using an invoice profile that was created in the
Manager module. Images of the invoices are captured and saved in TIFF file format which are then used
by the other Invoices modules to extract the information of interest from the corresponding invoices.

SCSI. Small Computer Systems Interface, a standard interface used to connect peripheral equipment
(hard disks, CD-ROM, scanners) to computers.

Status: Active/lnactive invoice profile” \b. An invoice profile can be Active or Inactive. Inactive invoice
profiles are in the process of being defined. Active invoice profiles are in production (that is, being
processed). An invoice being processed also has a status, as does each field on the invoice. There is a
detailed explanation in Invoices Help.

Supplier registry. A table containing information, imported from your financial system, that Invoices uses
to identify the suppliers of your invoices.

Table. Tables are used to store and look up values that are used for validation. You use the Manager to
create each table, give it a unique name, and save it to Invoices’ database.
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Target system. Invoices transfers information from processed invoices via a file to your target system,
which utilizes that information.

Title. A title is part of a field. The title is text that always appears on an invoice and that Invoices can use
to find the field. For example, the title for a date field might be Invoice date. A title is required for every
field that you want Invoices to learn automatically. When defining a field, you have to specify whether
there is a title for the field, and if so, what text it may contain and where it may be positioned in relation to
the value part of the field.

Transaction. Output information, extracted from processed invoices, that Invoices transfers to another
computer in the form of a transfer file. A transaction usually contains many records whose format is
specified by one or more transaction descriptions.

Transaction description. A collection of transaction fields that specify the content, format, and layout
of transactions. It specifies the format and layout of the output information from processed invoices that
Invoices transfers to a target system.

Transaction field. One line in a transaction description that specifies one piece of information that is to be
included in the corresponding transaction. The information usually consists of a value interpreted from a
processed invoice, a system variable, or other text.

Transfer. This module is used after invoices have been processed to transfer information from the
invoices to a target system, which can be another application in the same computer as Invoices or in
another computer. Information is transferred in transactions. You can specify which status of invoices you
would like to transfer.

Transfer file. After invoices have been processed, you use Transfer to transfer information from the
invoices to the target system. You can select to put the information in a file called the transfer file.

Value. A property of a field such as the date in a date field or the amount in an amount field.

Variant. An invoice or invoices that share an identifier field value and supplier with an already learned
invoice definition, but on which the fields have different positions. You use the Description box in Verify
and Optimize to differentiate variants.

Verify. The production module that is used to verify learned invoices or invoices identified by the Interpret
module. When an invoice has been processed by Verify, the invoice image and the information are ready
to be transferred to a file.

Verifying. The process of checking and correcting interpreted invoices. Invoices displays interpreted
fields, and you can approve and adjust fields as required.

You specify the parameters of the verifying process in the Verify job description

XML invoice. An invoice received from a supplier in any XML format. XML invoices are received

by ReadSoft Collector, processed in Kofax ReadSoft Invoices and transferred to the target system.
Depending on the context, this term can mean eaither the received XML document itself, or the object
inside the Kofax ReadSoft Invoices system (for example, when listing all XML Invoices in the XML
Maintenance dialog).
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